
P/N: 0302-5602B July 2023 

 
 

 

 

 

 

 

 

 

J-1000 series 
 

 

CD Spectrometer 
 

 

Software Manual 
 

 

 

Spectra ManagerTM Ver2.5 CFR 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



 

i 

Preface 
 

This instruction manual serves as a guide for using this software. It is intended to instruct first-

time users on how to properly use the software, and to serve as a reference for experienced 

users. 

 

Before using the software, read this instruction manual carefully, and make sure you fully 

understand its contents. This manual should be easily accessible to the operator at all times 

during software operation. When not using the software, keep this manual stored in a safe 

place. Should this instruction manual be lost, order a replacement from your local JASCO 

distributor. 

 

 

Servicing 
 

Contact your local JASCO distributor for instrument servicing. In addition, contact your JASCO 

distributor before moving the instrument to another location. Consumable parts should be 

ordered according to part number from your local JASCO distributor. If a part number is 

unknown, give your JASCO distributor the model name and serial number of your instrument. 
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Notices 
 

(1) JASCO shall not be held liable, either directly or indirectly, for any consequential damage 

incurred as a result of product use. 

(2) Prohibitions on the use of JASCO software 

 

• Copying software for purposes other than backup 

• Transfer or licensing of the right to use software to a third party 

• Disclosure of confidential information regarding software 

• Modification of software 

• Use of software on multiple workstations, network terminals, or by other methods 

(not applicable under a network licensing agreement concluded with JASCO) 

 

(3) The contents of this manual are subject to change without notice for product improvement. 

(4) This manual is considered complete and accurate at publication. 

(5) This manual does not guarantee the validity of any patent rights or other rights. 

(6) If a JASCO software program has failed causing an error or improper operation, this may 

be caused by a conflict from another program operating on the PC. In this case, take 

corrective action by uninstalling the conflicting product(s). 

(7) Windows is a registered trademark of Microsoft Corporation in the United States and other 

countries. In general, company names and product names are trademarks or registered 

trademarks of the respective companies. However, the TM and ® marks are not used in all 

cases in this manual. 

(8) JASCO and the JASCO logo are registered trademarks of JASCO Corporation in Japan 

and other countries. 
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Limited Warranty 
 

Products sold by JASCO, unless otherwise specified, are warranted for a period of one year from 

the date of shipment to be free of defects in materials and workmanship. If any defects in the 

product are found during this warranty period, JASCO will repair or replace the defective part(s) or 

product free of charge. 

 

THIS WARRANTY DOES NOT APPLY TO DEFECTS RESULTING FROM THE 

FOLLOWING: 

 

(1) IMPROPER OR INADEQUATE INSTALLATION 

(2) IMPROPER OR INADEQUATE OPERATION, MAINTENANCE, ADJUSTMENT OR 

CALIBRATION 

(3) UNAUTHORIZED MODIFICATION OR MISUSE 

(4) USE OF CONSUMABLE PARTS NOT SUPPLIED BY AN AUTHORIZED JASCO 

DISTRIBUTOR 

(5) CORROSION DUE TO THE USE OF IMPROPER SOLVENTS, SAMPLES, OR DUE TO 

SURROUNDING GASES 

(6) ACCIDENTS BEYOND JASCO'S CONTROL, INCLUDING NATURAL DISASTERS 

 

This warranty does not cover the consumable parts listed below: 

 

(1) Tungsten lamp,  and other light sources 

(2) Mirrors in the light source section, and cell windows 

(3) Fuses, batteries, glassware, chart paper and ink 

 

 

THE WARRANTY FOR ALL PARTS SUPPLIED AND REPAIRS PROVIDED UNDER THIS 

WARRANTY EXPIRES ON THE WARRANTY EXPIRATION DATE OF THE ORIGINAL 

PRODUCT. FOR INQUIRIES CONCERNING REPAIR SERVICE, CONTACT YOUR JASCO 

DISTRIBUTOR AFTER CONFIRMING THE MODEL NAME AND SERIAL NUMBER OF 

YOUR INSTRUMENT. 

 

 

 

 

 

 

 JASCO Corporation 

 2967-5, Ishikawa-machi, Hachioji 

 Tokyo 192-8537 

 Japan 
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Notation Used 
 

The following notational conventions are used throughout this manual: 

 

General Notation 

Notation Meaning 

[Measurement] menu 

[Parameters...] command 

Names of menus, commands, and text boxes are enclosed in 

square brackets ‘[ ]’, followed by a description indicating 

whether the function is a menu, command, text box, etc. 

Shortcut keys used to select menus or commands are 

underlined. 

<OK>, <Cancel> Names of buttons are enclosed in angular brackets ‘< >‘. 

 

Keyboard Operations 

Notation Meaning 

Shift  Ctrl  The key is enclosed in a square and shown in boldface. 

Alt , F Keys that are to be pressed in succession are separated by 

commas. In the example shown on the left, the Alt key is 

to be pressed and released, followed by the F key. 

Shift + →  Keys that are pressed simultaneously are separated by a 

"plus" sign. In the example shown on the left, press the → 

key while holding down the Shift key. 

 

Mouse Operations 

Notation Meaning 

Point Move the mouse pointer to the specified item. 

Click Quickly press and release the mouse button. 

Double-click Click the mouse button twice in rapid succession. 

Drag Point to an item, click and hold down the mouse button. 

Move the mouse with the button held down, and release 

the button when the pointer is in the desired position. 

  

 



 

v 

Contents 
 

Preface............................................................................................................ i 

Servicing ........................................................................................................ i 

Notices........................................................................................................... ii 

Limited Warranty ......................................................................................... iii 

Notation Used .............................................................................................. iv 

Contents ........................................................................................................ v 

1. Introduction ............................................................................................ 1 

1.1 How to Use This Manual ............................................................................. 1 

1.2 FDA 21CFR Part 11 .................................................................................... 2 

1.3 Features of [Spectra Manager] Compatible with FDA 21CFR Part 11 ......... 2 

1.4 Overview of [Spectra Manager]................................................................... 6 

2. Starting and Exiting Programs and the [Spectra Manager] Program R
eference .................................................................................................. 7 

2.1 Starting the program ................................................................................... 7 

2.1.1 Turning on the CD Spectrometer ....................................................... 7 

2.1.2 Starting the PC and Windows and Registering a J-1000 Series CD 

spectrometer ..................................................................................... 8 

2.1.3 Starting [Spectra Manager CFR] ...................................................... 23 

2.1.4 Components of the Program Window .............................................. 25 

2.2 Exiting the Program .................................................................................. 27 

2.2.1 Exiting [Spectra Manager CFR] ....................................................... 27 

2.2.2 Turning off the PC and CD Spectrometer ........................................ 28 

2.3 [Spectra Manager CFR] Program Reference ............................................ 28 

3. Accessory Registration Reference ..................................................... 30 

3.1 Installing/Attaching an Accessory ............................................................. 30 

3.2 Precautions for Peltier Thermostatic Cell Holder ....................................... 31 

3.2.1 Removing the Peltier Thermostatic Cell Holder ................................ 32 

3.3 Registering Accessories ........................................................................... 33 

3.3.1 Registering an Automatically-Recognized Accessory ...................... 33 

3.3.2 Registering an Accessory Requiring Manual Registration ................ 33 

3.4 Actions of [Spectra Manager] When Recognizing an Accessory ............... 36 

3.4.1 When an Automatically-Recognized Accessory is Attached ............. 36 

3.4.2 When the Automatically-Recognized Accessory is Removed .......... 37 

3.5 Status Display for the CD Spectrometer ................................................... 38 

4. Introduction to the [Spectra Measurement] Program ....................... 39 

4.1 Procedures for the [Spectra Measurement] Program ................................ 39 

4.2 Starting the [Spectra Measurement] Program ........................................... 40 

4.3 Specifying and Saving Measurement Parameters..................................... 41 

4.4 Reviewing and Approving the Parameter File ........................................... 48 

4.5 Measuring the Sample .............................................................................. 50 

4.6 Saving Spectra ......................................................................................... 52 

4.7 Printing Results ........................................................................................ 53 



 

vi 

4.8 Exiting the Program .................................................................................. 54 

5. Introduction to the [Time Course Measurement] Program ............... 55 

5.1 Procedures for the [Time Course Measurement] Program ........................ 55 

5.2 Starting the [Time Course Measurement] Program ................................... 56 

5.3 Specifying and Saving Measurement Parameters..................................... 57 

5.4 Reviewing and Approving the Parameter File ........................................... 64 

5.5 Measuring the Sample .............................................................................. 66 

5.6 Saving Time-Course Data ......................................................................... 68 

5.7 Printing Results ........................................................................................ 69 

5.8 Exiting the Program .................................................................................. 70 

6. Measurement Program Reference ...................................................... 71 

6.1 Overview of Measurement Programs ........................................................ 71 

6.2 [File] Menu ................................................................................................ 76 

6.2.1 [Save Data...] ................................................................................... 76 

6.2.2 [Send to Analysis] ............................................................................ 77 

6.2.3 [Open Parameters...] ....................................................................... 78 

6.2.4 [Save Parameters...] ........................................................................ 79 

6.2.5 [Open Baseline...] ............................................................................ 80 

6.2.6 [Save Baseline...] ............................................................................. 82 

6.2.7 [Print Setup...] .................................................................................. 83 

6.2.8 [Exit] ................................................................................................ 83 

6.3 [Measure] Menu ........................................................................................ 84 

6.3.1 [Cancel] ........................................................................................... 84 

6.3.2 [Sequence Measurement] ................................................................ 84 

6.3.3 [Sample Measurement] .................................................................... 84 

6.3.4 [Baseline Measurement] .................................................................. 85 

6.3.5 [Blank Measurement] ....................................................................... 85 

6.3.6 [Dark Measurement] ........................................................................ 86 

6.3.7 [Parameters...] ................................................................................. 86 

6.4 [Control] menu .......................................................................................... 87 

6.4.1 [Zero Clear] ..................................................................................... 87 

6.4.2 [Shutter] ........................................................................................... 87 

6.4.3 [Move Wavelength...] ....................................................................... 87 

6.4.4 [Detector ...] ..................................................................................... 88 

6.4.5 [Light Source...] ............................................................................... 89 

6.4.6 [Nitrogen Flowrate...] ....................................................................... 89 

6.4.7 [Select Detector...] ........................................................................... 89 

6.4.8 [Select Accessory...] ........................................................................ 90 

6.4.9 [Accessory Model Number] .............................................................. 91 

6.5 [View] Menu .............................................................................................. 92 

6.5.1 [Scales...] ......................................................................................... 92 

6.5.2 [Patterns...] ...................................................................................... 93 

6.5.3 [Fonts...] .......................................................................................... 94 

6.5.4 [Gridlines...] ..................................................................................... 95 

6.5.5 [Styles...] .......................................................................................... 96 

6.5.6 [Overlay] .......................................................................................... 97 

6.5.7 [Select Graph...] ............................................................................... 97 

6.5.8 [Information Bar] .............................................................................. 97 



 

vii 

6.5.9 [Accessory Bar] ............................................................................... 97 

6.5.10 [Toolbars] ........................................................................................ 97 

6.5.11 [Status Bar] ...................................................................................... 97 

6.5.12 [View Mode] ..................................................................................... 98 

6.5.13 [Graph View] .................................................................................... 99 

6.6 [Settings] Menu ......................................................................................... 99 

6.6.1 [Default Parameters...] ..................................................................... 99 

6.6.2 [Customize Toolbar...] .................................................................... 100 

6.6.3 [Monitor Bar...] ............................................................................... 102 

6.7 [Help] Menu ............................................................................................ 102 

6.7.1 [Contents] ...................................................................................... 102 

6.7.2 [Search Topic] ............................................................................... 102 

6.7.3 [About...] ........................................................................................ 102 

7. [Spectra Measurement] Program Reference .................................... 103 

7.1 [Parameters...] ........................................................................................ 103 

7.1.1 [General] tab .................................................................................. 104 

7.1.2 [Control] tab ................................................................................... 108 

7.1.3 [Information] tab ............................................................................. 109 

7.1.4 [Data] tab ....................................................................................... 110 

8. [Time Course Measurement] Program Reference ........................... 112 

8.1 [Parameters...] ........................................................................................ 112 

8.1.1 [General] tab .................................................................................. 113 

8.1.2 [Control] tab ................................................................................... 116 

8.1.3 [Information] tab ............................................................................. 117 

8.1.4 [Data] tab ....................................................................................... 118 

9. [Data Monitor] Program Reference ................................................... 120 

9.1 [Parameters…] ....................................................................................... 121 

9.1.1 [Parameters] .................................................................................. 121 

10. Appendix ............................................................................................. 124 

10.1 Setting the Measurement Parameters..................................................... 124 

10.1.1 Measurement Wavelength Range.................................................. 124 

10.1.2 Data Acquisition Interval (Resolution) ............................................ 124 

10.1.2.1 Spectra measurement............................................................. 124 

10.1.2.2 Time-course measurement ..................................................... 124 

10.1.3 Scanning Speed ............................................................................ 124 

10.1.4 Number of Accumulations .............................................................. 125 

10.1.5 Response (D.I.T.) .......................................................................... 125 

10.1.5.1 Spectra measurement............................................................. 125 

10.1.5.2 Time-course measurement ..................................................... 126 

10.1.6 Bandwidth and slit width ................................................................ 126 

 

  



 

viii 

  



 

1 

1. Introduction 

1.1 How to Use This Manual 
This manual is for the JASCO J-1000 series CD spectrometer measurement program that runs 

on Microsoft Windows. The J-1000 series CD spectrometer measurement program consists of 

[Spectra Manager CFR-Compliant Program], which conforms to FDA regulation 21 CFR Part 

11 concerning electronic records and electronic signatures, and [Spectra Manager v.2-

Compliant Program], which does not conform to these standards. This instruction manual 

refers to [Spectra Manager CFR-Compliant Program] and [Spectra Manager v.2-Compliant 

Program] as [CFR Version Program] and [Non-CFR Version Program], respectively. 

This chapter describes the structure and use of this manual. The manual consists of 7 chapters 

including this one. An explanation of each chapter is given below. For this manual, Microsoft 

Windows is referred to as Windows and a personal computer as a PC. 

 

1.  Introduction 

This chapter describes how to use this manual and gives an overview of each program and 

menu. Read this chapter first. 

 

2.  Starting and Exiting Programs and the [Spectra Manager] Program Reference 

This chapter describes detailed procedures ranging from turning on/off the CD spectrometer 

and PC to starting/exiting the programs. Refer to Chapter 3 for details about program 

operations. In addition, this chapter provides the [Spectra Manager] program reference. 

 

3.  Accessory Registration Reference 

This chapter describes how to register accessories used with the CD spectrometer. 

 

4.  Introduction to the [Spectra Measurement] Program 

This chapter describes the [Spectra Measurement/Analysis] programs with examples of basic 

procedures. Users unfamiliar with Windows or first-time users of the CD spectrometer should 

follow the procedures described in this chapter for a general overview of how to operate the 

program. 

 

5.   Introduction to the [Time Course Measurement] Programs 

This chapter describes the [Time Course Measurement] programs with examples of basic 

procedures. 

 

  



 

2 

6 to 9.  Measurement Program References 

These chapters describe common toolbar and menu commands for the [Spectra 

Measurement], [Time Course Measurement] and [Data Monitor] programs, in addition to the 

parameters used in these programs. Read the relevant chapters as required.  

6. Toolbar and menu reference. 

7. [Spectra Measurement] program reference 

8. [Time Course Measurement] program reference 

9. [Data Monitor] program reference 

 

10.  Appendix 

This chapter provides useful suggestions for specifying parameters for CD measurements. 

 

1.2 FDA 21CFR Part 11 
FDA 21 CFR Part 11 is a set of regulations regarding digital archiving of data and data records 

for GLP, GCP, and GMP procedures. These regulations cover a number of areas, including: 

1) access control and electronic signature requirements for data recorded by any computer-

controlled analytical system in which the results are digitally archived; 2) the provision of 

security functions that can only be accessed by authorized personnel to ensure the security 

and integrity of data; and 3) a data auditing mechanism with the automatic creation of an Audit 

Trail to maintain a record of any creation, modification or deletion of instrument data. 

 

1.3 Features of [Spectra Manager] Compatible with FDA 
21CFR Part 11 

JASCO Spectra ManagerTM is an integrated software package that acts as a common platform 

for the range of JASCO analytical instruments. The Spectra ManagerTM software provides 

functionality ranging from analytical instrument control and spectral data processing to 

sophisticated and specialized data analysis programs. JASCO Spectra ManagerTM Ver.2.5 

CFR provides security and auditing functionality that ensures the security, integrity and 

confidentiality of electronic records by enforcing the use of electronic signatures and other 

security measures as described in the regulations outlined in 21 CFR Part 11. 

In addition, in order to ensure strict data integrity, functions are provided for electronically 

recording intermediate results even in the case where a measurement is stopped, either for a 

single spectrum or time-dependent spectral data. Also, saving of data before and after 

changing metadata such as the sample name or comments is strictly enforced. 

JASCO Spectra ManagerTM CFR consists of three core modules: Administrative Tools and 

Security Manager modules; intrinsic components of the Spectra ManagerTM CFR software; and 

a database, which is an external component to the Spectra ManagerTM CFR software. In 

addition, there are two broad classes of add-on modules: instrument drivers, which are 

spectrometer, or accessory-specific; and spectral analysis modules, which provide a range of 

sophisticated analytical and data processing tools. These add-on modules integrate 

seamlessly with the three core components of the Spectra Manager system to provide 

compliance with 21 CFR Part 11 regulations over the entire range of JASCO products. Figure 
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1.1 illustrates the system organization. 

 
Figure 1.1 Structure of Spectra ManagerTM CFR 

All of the security management functions of JASCO Spectra ManagerTM CFR are accessed 

through the Administrative Tools interface. The Security Manager components of the system 

are not directly accessible by a user, and thus the operation of these modules is not described. 

For secure management of data and data records, JASCO Spectra ManagerTM CFR has two 

levels of security: system-level security and workgroup-level security. 

 

When a user is registered in JASCO Spectra ManagerTM CFR, the user must be assigned to 

one of four possible System Access Levels: “Administrators”, “Power Users”, “Users”, or 

“Limited Users”. The level of control that a user has over the management functions of the 

software system is determined by the System Access Level assigned to that user. Table 1.1 

outlines the different rights assigned to the different types of users depending on their System 

Access Levels. Users with an “Administrators” system access level are referred to as “[Spectra 

Manager CFR] administrators”. In contrast, users belonging to the “Administrators” group in 

Windows are referred to as “Windows administrators”. 

Note: An “Administrators” access level has no relation to “Windows administrator” and 

means administrator privileges for the [Spectra Manager CFR] program. 

Table 1.1 Rights of each System Access Level 

 Administrators Power Users Users Limited Users 

Display/modify system policy OK    

Add/delete users OK    

Enable/disable user account OK    

Modify user properties (incl. System 
Access Level) 

OK    

Add a workgroup OK    

Enable/disable a workgroup OK    

Modify workgroup users  Workgroup Managers only   

Add/delete instruments OK    

Modify instrument configuration OK    

Add/delete programs OK    

Display log management OK OK   
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Workgroups correspond to actual groupings of users within the organization and may 

represent divisions such as projects, departments, or research groups. Each workgroup has a 

set of users, instruments, accessories, and analysis programs associated with it; only users 

registered with a specific workgroup may access the instruments and programs of that 

workgroup. Within a workgroup, users are granted access as either a “Manager”, “Analyst”, or 

“Operator”, with authorities to modify instrument and analysis settings and use resources within 

the workgroup determined by the Workgroup User Rights granted. Selectable Workgroup User 

Rights vary depending on the system access level of the user. Table 1.2 outlines the 

relationship between the System Access Levels and Workgroup User Rights. 
 

Table 1.2 Qualified access levels by Workgroup User Rights 

 Administrators Power Users Users Limited Users 

Managers OK OK   

Analysts OK OK OK  

Operators OK OK OK OK 

 

By employing a two-level security model, global security authorization is independent of instrument, 

accessory, and application authorization, resulting in a highly flexible security system. Table 1.3 

outlines the different rights assigned to the different types of users depending on their Workgroup 

User Rights. 

Table 1.3 Rights of each Workgroup User Rights 

 Managers Analysts Operators 

Register/unregister workgroup users  OK   

Change Workgroup user authorities   OK   

Register/unregister instruments for the workgroup OK   

Register/unregister programs for the workgroup OK   

Use a registered instrument  OK OK OK 

Use a registered instrument application OK OK OK 

Modify measurement parameters  OK OK  

Use a registered analysis program OK OK OK 

Modify analysis parameters OK OK  

Electronically sign data OK OK OK 

 

Figure 1.2 shows the typical operational flow of the JASCO Spectra ManagerTM CFR. First, a 

user is created (registered) and their System Access Level is assigned using Administrative 

Tools. A Workgroup is created (registered), and individual users and analytical instruments are 

assigned to the Workgroup. Detailed access to instrument control and analysis programs can 

be set at the User and Workgroup levels. Access control levels as required by FDA 21 CFR 

Part 11 regulations are determined by the Administrative Tools settings. 
 

Routine analyses can then be conducted by the operator using the measurement/analysis 

programs in JASCO Spectra ManagerTM CFR. Since all levels of access are managed by 



 

5 

Security Manager, individual users are only able to execute procedures that are allowed by 

their assigned access level. Access control ranges from declaring measurement parameters 

to conducting measurements and performing data analysis. 
 

Analytical data obtained using any of the procedures described above can be saved as an 

electronic record with an electronic signature.  

 
Figure 1.2 Operational flow 
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1.4 Overview of [Spectra Manager] 
[Spectra Manager] refers to the entire suite of measurement/analysis and administrative 

programs for JASCO CD spectrometers. 

Specifically, [Spectra Manager] is a software program that communicates with the CD 

Spectrometer to start various measurement and analysis programs. Common programs that 

are used include programs for performing measurements using the CD Spectrometer, the 

[Validation] program for checking the performance of the CD spectrometer, and the [Spectra 

Analysis], [JASCO Canvas] and [Administrative Tools] programs. 

 

Spectra Measurement Controls the CD spectrometer and measures samples. 

Validation  Checks the performance of the CD spectrometer. 

Spectra Analysis Displays, processes, and prints the data obtained by [Spectra 

   Measurement]. 

JASCO Canvas Customizes the format of spectral data for printing. 

Administrative Tools Controls the administration of the CD spectrometer and 

measurement/analysis programs including the assignment of user 

authority. 

 

This manual mainly explains how to use several of the measurement programs. Refer to 

[Hardware Manual] for details about how to use the CD spectrometer. Refer to the individual 

instruction manuals for details about the [Validation], [Interval Scan Measurement], [Spectra 

Analysis], [Interval Data Analysis], and [JASCO Canvas] programs. 
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2. Starting and Exiting Programs and the [Spectra 
Manager] Program Reference 

2.1 Starting the program 

2.1.1 Turning on the CD Spectrometer 

 

(1) Confirm that the standard detector is installed in the J-1000 series CD spectrometer. If 

another detector has been installed, replace it with the standard detector. Refer to the 

hardware manual “Model J-1100/1500 CD Spectrometer” or “Model J-1700 CD 

Spectrometer” for instructions on removing or installing the detector. 

(2) Supply nitrogen gas at a flow rate of at least 2 L/min. Absorption due to oxygen increases 

with decreasing wavelength, which reduces the light intensity reaching the detector. 

Please increase the flow rate to optimize the intensity within the desired wavelength range. 

Nitrogen flow rate for different measurement wavelength ranges: 

Up to 185 nm    2 L/min 

Up to 180 nm   5 L/min 

Up to 175 nm   15 L/min 

Less than 175 nm  More than 15 L/min 

Note: Depending on the residual amount of nitrogen gas present when the spectrometer is 

first turned on, it is possible for absorption due to oxygen to be high even if the 

recommended nitrogen flow rate is used. In this case, pre-purge at a nitrogen flow 

rate of 15 L/min before performing measurements. The recommended pre-purge 

times are: 10 min for wavelengths up to 185 nm, 30 min for wavelengths up to 180 

nm and 60 min for wavelengths up to 175 nm. 

(3) When using the 450 W Xe lamp, feed cooling water to the light source at a flow rate of 

about 2 L/min. 

(4) Turn on the "Power" switch at the left side of the CD spectrometer. 

WARNING!: Running the xenon (Xe) lamp in air will generate ozone gas, which is harmful 

to humans. Always supply nitrogen gas for a few minutes before turning on 
the light source. 

 

 

Note 1: When performing measurements at wavelengths shorter than 180 nm, to maintain the 
effect of the nitrogen purge, after inserting or removing samples close the sample 
compartment lid as soon as possible. 

Note 2: A high nitrogen flow rate is necessary when performing measurements at 
wavelengths shorter than 175 nm because of the sharp increase in absorption due to 
oxygen. 

Note 3: Ozone gas absorbs light at wavelengths of 200 to 300 nm and 600 to 700 nm. This 
makes it difficult to perform measurements in these wavelength regions and can also 
damage optical parts due to corrosion. Always supply nitrogen gas before turning on 
the light source. 

Note 4: Never use helium gas. It will permeate into the photomultiplier tube, reducing the 
vacuum level and the functionality of the tube. 
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Note 5: If a PC-controlled nitrogen gas flow meter (an optional accessory) is installed, all that 
is necessary to do is to simply open the main valve of the gas cylinder. Nitrogen will 
start flowing when the spectrometer is started. The flow rate can be controlled via the 
measurement program. 

Note 6: Step (3) is not necessary with the 150 W Xe lamp, which is cooled with air. 
Note 7: Just turning ON the "Power" switch does not result in the light source being turned 

on. The light source will be turned on automatically when the measurement program 
is started. 

 

2.1.2 Starting the PC and Windows and Registering a J-1000 Series 
CD spectrometer 

Turn on the PC and monitor to start Windows. When a J-1000 series CD spectrometer is 

connected for the first time, registration of the CD spectrometer is required in [Spectra 

Manager]. 

Note: The operations described in this section can be performed only by Administrators. 

(1) Start [Administrative Tools], right-click [Instrument] and select [Register Instrument...] 

from the shortcut menu to display the window in Figure 2.1. 

 

Figure 2.1 [Administrative Tools] window 

(2) Select the check box for the JASCO J-1000 series control driver and click the <Next> 

button to display the dialog box in Figure 2.2. 

 

Figure 2.2 [Select Instrument Driver] dialog box 
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(3) Enter the CD spectrometer name, model name and serial number and then click the 

<Finish> button to register the CD spectrometer. The model name and serial number are 

inscribed on the name plate on the rear panel of the CD spectrometer. 

 

Figure 2.3 [Instrument Properties] dialog box 

The CD spectrometer is registered and the name is displayed in the right pane of the 

[Administrative Tools] window. 

 

Figure 2.4 [Administrative Tools] window 

Note: After registering the CD spectrometer, exit the program and perform the following 

operations after logging on again. 
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(4) Restart [Spectra Manager] and start [Administrative Tools]. Right-click the registered CD 

spectrometer name and select [Properties...] to display the dialog box in Figure 2.5 . First, 

check that [Model name], [Display name], [Serial number], and [Driver version] are 

displayed in the [General] tab. 

 

Figure 2.5 [General] tab in [Properties] dialog box 
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(5) Click the [Composition] tab to set parameters for the nitrogen gas flow meter and the 

light source. 

    

Figure 2.6 [Composition] tab in [Properties] dialog box J-1700 (left), J-1500 (right) 

Nitrogen-gas  

[Preflow time] Specifies the nitrogen gas preflow time before the xenon 

light source is turned on. 

[Select flowmeter] Selects the nitrogen gas flow meter. 

[Manual without sensor]: Select this when using a manual 

flow meter with no sensor. 

[Manual with sensor]: Select this when using a manual flow 

meter with a sensor. 

[Automatic (PC control)]: Select this when using a PC-

controlled automatic flow meter. 

[Details] Specifies the flow rate of nitrogen gas under each contition. 

Note: Refer to the "J-1000 Nitrogen Flow Meter 

Instruction Manual" for details. 

[Set up automatically at 

measurement] 

Specifies the nitrogen gas flow rate for the idling or 

measurement state. The flow rate is automatically 

controlled. This function is only available when the 

[Automatic (PC control)] flow meter is selected. 
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[Return to standard flow after 

a measurement end] 

Specifies that the flow rate is automatically returned to the 

standard flow rate after measurement. This function is only 

available when the [Automatic (PC control)] flow meter is 

selected. 

[Turn off lamp after gas flow 

error] 

Specifies that the lamp is automatically turned off after a 

gas flow error has occurred. This function is only available 

when the [Automatic (PC control)] or [Manual with sensor] 

flow meter is selected. 

[Lamp off timer] Specifies the time before the light source is automatically 

turned off after a nitrogen gas flow error has occurred. This 

function is only available when the [Automatic (PC control)] 

or [Manual with sensor] flow meter is selected. 

Lamp  

[Turn on xenon lamp when 

program starts] 

Specifies that the Xe lamp is automatically turned on when 

the measurement program is started. 

[Turn on halogen lamp when 

program stars] 

Specifies that the WI lamp is automatically turned on when 

the measurement program is started. (only for J-1700) 

[Use an external light source 

(Halogen lamp)] 

Specifies that the external halogen lamp is used. (only for 

J-1500) 

<I/O signal output...> Specifies that each signal (drain, external start, 

measurement end, light source turns off and error) from 

the CD spectrometer is sent to the accessory attached to 

the I/O ports. Select the desired check boxes. When the 

accessory is made by JASCO, these settings are 

unnecessary. 

 

Figure 2.7 [I/O Signal Output] dialog box  
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(6) Click the [Photometric mode] tab to register the photometric mode. 

The electric signals except other than CD signals can be detected using the J-1000 series 

CD spectrometer. The photometric modes selected in this dialog box are displayed in the 

measurement program. For J-1100, the available photometric modes are limited. 

  

Figure 2.8 [Photometric mode] tab in [Properties] dialog box J-1500/1700 (left), J-1100 (right) 

CD Measures the circular dichroism signal 

LD Measures the linear dichroism signal 

ORD-M Measures the optical rotational dispersion signal. The ORD-

M accessory is required. (Not available for J-1100) 

ORD-E Measures the optical rotational dispersion signal. The ORD-

E accessory is required. (Not available for J-1100) 

HT Measures the high-tension (HT) voltage applied to the CD 

photomultiplier tube in the transmission configuration. 

DC Measures the direct current (DC) voltage applied to the CD 

photomultiplier tube in the transmission configuration. 
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FDCD Measures the fluorescence detected circular dichroism 

signal. The FDCD accessory is required. (Not available for 

J-1100) 

ΔF = Fl - Fr 

Fl: Fluorescence intensity excited by left circularly polarized 

light  

Fr: Fluorescence intensity excited by right circularly 

polarized light 

FDLD Measures the fluorescence detected linear dichroism 

signal. The FDCD accessory is required. (Not available for 

J-1100) 

ΔF = F// - F⊥ 

F//: Fluorescence intensity excited by horizontally linear 

polarized light  

F ⊥ : Fluorescence intensity excited by vertically linear 

polarized light 

Anisotropy Measures the fluorescence anisotropy signal. (Not 

available for J-1100). 

D.F.P. Measures the degree of fluorescence polarization signal. 

(Not available for J-1100). 

DRCD Measures the circular dichroism signal using detector for 

fluorescence configuration 

DRLD Measures the linear dichroism signal using detector for 

fluorescence configuration 

CD/DC Measures the CD and DC signals and displays the CD 

signal divided by the DC signal. 

FDCD/DC Measures the FDCD and DC signals and displays the 

FDCD signal divided by the DC signal. (Not available for J-

1100). 

Abs. Measures the absorption spectrum. The absorption signal 

is obtained by conversion of the HT signal. Select this when 

the HT voltage for the photomultiplier tube in the 

transmission configuration is set to Auto. 

UV single (Abs.) Measures the absorption spectrum. The absorption signal 

is obtained by conversion of the DC signal. Select this when 

the HT voltage for the photomultiplier tube in the 

transmission configuration is set to Manual. 

UV single (%T) Measures the transmittance (%T) spectrum. The %T signal 

is obtained by conversion of the DC signal. Select this when 

the HT voltage for the photomultiplier tube in the 

transmission configuration is set to Manual. 
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Intensity Measures the fluorescence intensity. Select this when the 

HT voltage for the photomultiplier tube in the fluorescence 

configuration (90 degrees with respect to the measurement 

beam direction) is set to Auto. 

(Not available for J-1100) 

UV double (Abs.) Measures the absorption spectrum using a UV double 

beam attachment. (Not available for J-1100) 

UV double (%T) Measures the transmittance spectrum using a UV double 

beam attachment. (Not available for J-1100) 

HT(FL) Measures the applied voltage (HTV) to the photomultiplier 

tube in the fluorescence configuration (90 degrees with 

respect to the measurement beam direction). (Not available 

for J-1100) 

DC(FL) Measures the direct current (DC) voltage to the 

photomultiplier tube in the fluorescence configuration (90 

degrees with respect to the measurement beam direction). 

(Not available for J-1100) 

pH Measures the direct current signal from the pH meter. The 

pH meter is required. 

External 1 Measures the signal from external signal input 1 ("EXT 1" 

terminal on the rear panel of the amplifier). 

External 2 Measures the signal from external signal input 2 ("EXT 2" 

terminal on the rear panel of the amplifier). 

Test signal This is mainly used for checking the instrument. 

aw Measures the 50 kHz signal from the detector in the 

transmission configuration for the measurement beam. 

(Used for JASCO service engineers.) 

a2w Measures the 100 kHz signal from the detector in the 

transmission configuration for the measurement beam. 

(Used for JASCO service engineers.) 

aw(FL) Measures the 50 kHz signal from the detector in the 

fluorescence configuration (90 degrees with respect to the 

measurement beam direction) for the measurement beam. 

(Used for JASCO service engineers. Not available for J-

1100) 

a2w(FL) Measures the 100 kHz signal from the detector in the 

fluorescence configuration (90 degrees with respect to the 

measurement beam direction) for the measurement beam. 

Used for JASCO service engineers. (Not available for J-

1100) 
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The example of combination in accessories and photometric mode 

Accessory Potometric mode 

FDCD unit FDCD, FDLD, DC(FL) 

Set the FL detector HT voltage mode to Manual 

Integrating sphere DRCD, DRLD, HT(FL) 

Emission monochromator 

(FDT-538) 

Intensity 

Set the FL detector HT voltage mode to Manual 

Stopped flow CD/DC, DC 

Set the CD detector HT voltage mode to Manual 

ORDM-520 ORD-M, HT 

ORDE-521 ORD-E, HT 

 

 

 

 

Figure 2.9 Configuration of detectors 

(7) Click the [Detectors], [Measurement Units], [Cell Units] and [External Accessories] tabs 

to register detectors, measurement units, cell units, and external accessories, 

respectively. Refer to Chapter 3 for details about registering accessories. 

  

 M0 

M1 

LS1 
LS2 

M6 

SH S1 

S2 

S3 

M2 

M3 

M4 

M5 

P1 

F 

P2 

L 

CDM 

O-ray 

E-ray 

D 

Detector for transmission 

configuration 

 

Detector for fluorescence 

configuration 
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(8) Click the [Adjustments] tab to perform CD spectrometer adjustments. 

  

Figure 2.10 [Adjustments] tab in [Properties] dialog box 1700 (left), J-1100/1500 (right) 

Diagnostic  

<Diagnostics...> Confirms whether the CD spectrometer is functioning 

correctly. 

Initialization  

<Main Unit> Initializes the instrument settings. 

<Wavelength> Initializes the wavelength settings. 

<Slit> Initializes the slit width settings. 

Lamp  

[Xe lamp] Displays the number of hours the xenon lamp has been 

used. When the xenon lamp is exchanged, click the 

<Exchange> button to reset the number of hours used to 0. 

[WI lamp] Displays the number of hours the halogen lamp has been 

used. When the halogen lamp is exchanged, click the 

<Exchange> button to reset the number of hours used to 0. 

(only for J-1700) 
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[Hg lamp] Displays the number of hours the mercury lamp has been 

used. When the mercury lamp is exchanged, click the 

<Exchange> button to reset the number of hours used to 0. 

[Display warning message 

when the lamps have been 

used for more than 1000 hr] 

Displays a warning message when the xenon and/or 

halogen lamp have been used for more than 1000 hours 

(see Figure 2.11). Halogen lamp can be selected only for J-

1700. 

 

Figure 2.11 Warning message for xenon lamp usage time 

Note: The lifetime of the xenon lamp is 

approximately 1000 hours. When it has been 

used for more than 1000 hours, the decrease 

in intensity of the light source will effect 

measurements. 

CD scale Calibrates the scale for CD signal. Used for users. 

Record log Records a log of J-1000. When error occurs, send a log to 

JASCO  service engineers. 

 

Figure 2.12 [Log Information] dialog box 
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Click the <Diagnostics...> button to display the [Diagnostics] dialog box. This function 

confirms whether the CD spectrometer is functioning correctly. 

 

Figure 2.13 [Diagnostics] dialog box 

If an error message is displayed in the message area, contact your local JASCO distributor. 
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(9) Click the [Adjustment (J-1700)] tab to perform CD spectrometer adjustments. (Only J-

1700) 

 

Figure 2.14 [Diagnostics] dialog box 

Changeover wavelengths  

<Setting…> Sets the changeover wavelengths for light source, grating 

and detectors. 

 

Figure 2.15 [Changeover Wavelength Settings] dialog box 
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Wavelength calibration  

<Execute…> Calibrates the wavelength for grating in NIR region. 

 

Figure 2.16 [Wavelength Calibration] dialog box 

M5 optics adjustment  

<Adjust> Adjusts the M5 mirror in UV/Vis or NIR region. 

 

Figure 2.17 [M5 Optics Adjustment] dialog box 

Auto detector changer  

<Setting> Sets current detector positions. 

 

Figure 2.18 [Auto Detector Changer] dialog box 
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(10) Click the [Servicing] tab to calibrate CD spectrometer conditions such as the detector 

sensitivity. If calibration is required, contact your local JASCO distributor. 

 

Figure 2.19 [Calibrations] tab in [Properties] dialog box 

Hg lamp Turns the mercury lamp on or off. 

Detector synchronization Calibrates the phase shift of the CD and FL detectors. Used for 

JASCO service engineers. 

Data offset/scale Calibrates the offset and scale of Main unit (J-1000). Used for 

JASCO service engineers. 

Detector gain Calibrates the scale for CD, LD, ORDE and anisotropy signals. 

Used for JASCO service engineers. 

HT-OD conversion Calibrates the HT-OD conversion equation. Used for JASCO 

service engineers. 

Maintenance Used for JASCO service engineers. 

Note: In the CFR version, J-1000 must be registered to Workgroup before use. Refer to the 

[Spectra Manager CFR Administrative Tools] manual for details about registering the 

CD spectrometer to Workgroup. 
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2.1.3 Starting [Spectra Manager CFR] 

(1) After starting Windows, double-click the [Spectra Manager] icon located on the Windows 

desktop. Type the username and password in the logon dialog box to display the 

window in Figure 2.20. 

Note: [Spectra Manager] can also be started by selecting [Start] - [All Programs] - [JASCO] 

- [Spectra Manager CFR] from the Windows [Start] menu. 

 

Figure 2.20 [Spectra Manager CFR] window 
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(2) Start the [Spectra Measurement] program to measure a sample. 

Double-click [Spectra Measurement] from the [Instrument] list of [Spectra Manager] to 

start the program. The window in Figure 2.21 is displayed. 

 

Figure 2.21 [Spectra Measurement] window 
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2.1.4 Components of the Program Window 

In this section, the [Spectra Analysis] program window is used as an example to explain 

program operation components. The names of the various components (windows and dialog 

boxes) are also described. 

 

View window 

[Spectra Analysis] shows multiple spectrum display windows (called “Views”) in the main 

program window. Views have no dedicated menu bar, toolbar or status bar. Instead, the 

toolbar buttons and other components in the [Spectra Analysis] program window can be 

used for the active View window. 

 

Figure 2.22 “Views” in [Spectra Measurement] program window 

Dialog boxes 

Commands and menu items ending with an ellipsis (...) open a dialog box when clicked. 

The opened dialog box usually contains parameters that must be specified. The [Styles] 

dialog box from the [View] menu is used as an example to explain the names and functions, 

as well as the operational rules for various sections of the dialog box. 

 

View 
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To display the [Styles] dialog box in Figure 2.23, select [Styles...] from the [View] menu in 

the [Spectra Analysis] program. The names of various sections of the dialog box are 

indicated below. 

 

Figure 2.23 [Styles] dialog box 

Command button 

 

Option button 

The colored dot (•) 
shows that an option 
has been selected. 

Drop-down list 

ト 

Check box 

 Text box 

 

Group 
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2.2 Exiting the Program 

2.2.1 Exiting [Spectra Manager CFR] 

(1) Select [Exit] from the [Program] menu to close [Spectra Manager CFR]. 

Note: [Spectra Manager CFR] can also be exited by clicking the <Close> button. 

 

Figure 2.24 [Spectra Manager CFR] window 

[Spectra Manager CFR] cannot be exited before closing the running 

measurement/analysis programs. If programs are running, the dialog box in Figure 2.25 

is displayed. After clicking the <OK> button, close the running programs. 

 

Figure 2.25 Message when a program is still running 
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(2) Exiting Windows 

Exit Windows in accordance with standard Windows operation procedures. 

 

2.2.2 Turning off the PC and CD Spectrometer  

(1) First, turn off the PC and monitor. Do not forget to turn off the monitor. 

(2) Ensure that the sample compartment is empty, and then turn off the CD spectrometer. 

2.3 [Spectra Manager CFR] Program Reference 
[Spectra Manager CFR] is an integrated software package that acts as a common platform for 

the entire range of JASCO analytical instruments. 

 

Figure 2.26 [Spectra Manager CFR] window  

The standard measurement and analysis programs are displayed in Figure 2.26. When an 

optional program is installed, it is added to one of these lists. 

Note 1: The CD Spectrometer is also referred to as the “instrument” in this manual. 

Note 2: “Communication” refers to sending a control signal from the PC to the CD 

spectrometer or transferring measured data from the CD spectrometer to the PC. 

[Analysis] list 

When an analysis program is installed, it is added to 

this list. Start a program by double-clicking its name. 

[Instrument] list 

Displays the names of instruments that are currently 

available for use. For each instrument, a list of available 

programs is displayed. Start a program by double-clicking its 

name. 



 

29 

Menu 

[Program] menu 

[Administrative Tools] Starts the [Administrative Tools] program. 

[Change Password...] Changes the current password. 

[Logoff...] Logs off the current user. 

[Exit] Exits [Spectra Manager]. 

[User] menu 

[Change Workgroup...] Changes the Workgroup. 

[View] menu 

[Status Bar] Shows/hides the status bar. 

[Help] menu 

[Contents] Displays the Help contents window. 

[Search Topic] Displays the Help search function window. 

[About...] Displays version information about the CD spectrometer 

control driver. 
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3. Accessory Registration Reference 
The J-1000 series CD spectrometers and software automatically recognize an attached 

accessory, display information about the accessory, and start registered programs based on 

recognized accessories. This chapter provides information of installing and registering 

accessories, the program that is started when an accessory is recognized, and the actions of 

[Spectra Manager CFR] when recognizing an accessory. 

 

3.1 Installing/Attaching an Accessory 
Accessories for J-1000 series CD spectrometers are automatically recognized. Information 

about the respective accessory is contained within the accessory itself. The accessory is 

recognized when its cable is connected to the sample compartment connector. When installing 

a J-1000 accessory, confirm that the accessory cable is properly connected to the CD 

spectrometer connector. 

 

Figure 3.1 Location of J-1000 accessory connectors 

Accessory connector 

Accessory connecter 

(for Peltier cell holder) 
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3.2 Precautions for Peltier Thermostatic Cell Holder 
The electrical power for the Peltier thermostatic cell holder is supplied from the J-1000 series 

CD spectrometer when this accessory is connected and detected by the instrument. When 

power is being supplied, an icon is displayed on the status bar. 

 

Figure 3.2 Icon displayed on the status bar after the Peltier thermostatic cell holder has been 

recognized 

Peltier thermostatic cell 

holder recognition icon 
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3.2.1 Removing the Peltier Thermostatic Cell Holder 

This section describes how to remove the Peltier thermostatic cell holder while the J-1000 

series instrument is running. 

(1) Click the cursor on the accessory icon to display the [Safely Remove Temp unit] pop-up 

menu. 

 

Figure 3.3 Pop-up prompt for safely removing the thermostatic unit  

(2) Left-click the command to display the [Safely Remove Thermostatic Unit] dialog box. 

 

Figure 3.4 [Safely Remove Thermostatic Unit] dialog box 

(3) Click the <Yes> button. The electrical power supply for the Peltier thermostatic cell 

holder will be stopped and the cell holder can now be safely removed. 

 

Figure 3.5 Confirmation message that thermostatic unit can be safely removed 

To use the Peltier thermostatic cell holder again, reconnect its accessory cable to the J-

1000 series instrument. 
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3.3 Registering Accessories 
This section describes the procedure for registration of accessories used with the CD 

spectrometer. 

 

3.3.1 Registering an Automatically-Recognized Accessory 

(1) Confirm that the instrument is turned on and that [Spectra Manager] is running. 

(2) Connect the automatically-recognized accessory to the sample compartment. The 

accessory name, accessory ID and serial number are automatically registered. 

 

3.3.2 Registering an Accessory Requiring Manual Registration 

Note: This operation can be performed only by Administrators. 

(1) Confirm that the CD spectrometer is turned on and that [Spectra Manager] is running.  

(2) After starting [Administrative Tools], right-click the instrument name and select 

[Properties...] (see Figure 3.6). 

 

Figure 3.6 J-1000 instrument shortcut menu 

(3) Click the [Detectors] tab, [Measurement Units] tab, [Cell Units] tab or [External 

Accessories] tab. 

 

Figure 3.7 [Detectors] tab in [Properties] dialog box  
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(4) Select the type from the [Type] drop-down list. 

Table 3.1 Detectors 

Type 

Standard WL Detector (PMT): PM-539 

Extended WL Detector (ExPMT): EXPM-531 

Extended WL Detector (InGaAs): InGaAs-532 

Extended WL Detector (APD) : EXAP-533 

FDCD Detector (PMT): PMJ-534  

FDCD Detector (ExPMT): EXPML-535 

FDCD Detector (InGaAs): EXLGL-536 

FDCD Detector (APD) : EXAPL-537 

FL Intensity Detector : FDT-538 

Em Detector: FDT-455 

ORD-M Detector (PMT): PM-540  

Extended WL Detector (InSb) : INSB-541 

(only for J-1700) 

Note: For J-1100, the [Detectors] tab is not displayed. 

Table 3.2 Measurement Units 

Type 

ORD Attachment 

Fluorescence Monochromator 

Note: For J-1100, the [Measurement Units] tab is not displayed. 

Table 3.3 Cell Units 

Type 

Cell Holder 

Temperature Controller 

Flow Cell 

Integration Sphere 

FDCD Attachment 

Double Beam UV Attachment 

MCD Controller 

Stopped Flow Controller 

Cryostat Holder 

High Temp. Cell Unit 

Note: For J-1100, only the cell holder and temperature controller can be selected. 
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Table 3.4 Accessories 

Type 

Automatic Titrator 

Circulator 

Autosampler 

PAL Unit 

 

(5) Click the <Add...> button to display the dialog box in Figure 3.8. 

 

Figure 3.8 [Register Accessory] dialog box 

(6) [Name] is automatically entered by selecting the accessory in the [Accessory ID] drop-

down list. Type the serial number and a comment as required, and then click the <OK> 

button to register the accessory and display it in the list of registered accessories. 
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3.4 Actions of [Spectra Manager] When Recognizing an 
Accessory 

This section describes the actions of [Spectra Manager] running a measurement program 

when an automatically-recognized accessory with registered programs is attached to or 

removed from the CD spectrometer. 

Note: Do not attach/remove an automatically-recognized accessory while the program is 

displaying a dialog box or message. 

3.4.1 When an Automatically-Recognized Accessory is Attached 

When an automatically-recognized accessory is attached, a dialog box stating “An accessory 

has been attached” is displayed, and information on that accessory is displayed on the 

accessory bar. 

 

Figure 3.9 Message when an automatically-recognized accessory is being attached  

while [Spectra Manager] and a measurement program are running 
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3.4.2 When the Automatically-Recognized Accessory is Removed 

When an automatically-recognized accessory is removed, a dialog box stating “An accessory 

was removed” is displayed, and information on that accessory disappears from the accessory 

bar. 

 

Figure 3.10 Message when an automatically-recognized accessory is removed 

 while [Spectra Manager] and a measurement program are running 
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3.5 Status Display for the CD Spectrometer 
This section describes the display of the CD spectrometer status in a measurement program. 

 
Figure3.11 Status of CD spectrometer 

Water Leak (Sample 

Chamber) 

When water leakage occurs in the sample compartment, the green 

indicator in the status box turns red. A stop valve, an optional 

accessory, automatically prevents water from leaking. 

Temperature (Lamp) When the light source temperature exceeds 80 °C, the green 

indicator turns red and the light source is turned off automatically. 

N2 gas Flow When the nitrogen flow rate is less than the specified value, the 

green indicator turns red. This item is displayed only when the 

[Manually with sensor] or [Automatic (PC control)] flow meter is 

used. 

Note 1:  For the [Manually with sensor] type, the sensor position 

can be changed and the flow rate can be specified. 

Note 2: For the [Automatic (PC control)] type, when the flow 

rate is less than the idling flow rate specified in the 

[Administrative Tools] program, the green indicator 

turns red. 

CD signal Overload When the CD signal exceeds the upper limit of the measurement 

range specified by [CD scale] in the [Parameters] dialog box, the 

green indicator turns red. Specify a larger CD scale. 

FDCD signal Overload When the FDCD signal exceeds the upper limit of the measurement 

range specified by [FL scale] in the [Parameters] dialog box, the 

green indicator turns red. Specify a larger FL scale. 
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4. Introduction to the [Spectra Measurement] 
Program 

This chapter describes how to use the [Spectra Measurement] program, including procedures 

for starting the [Spectra Measurement] program, measuring the spectrum of a sample, and 

saving and printing data, for practice in operating a JASCO CD spectrometer. 

Explanations of the parameters have been kept to a minimum, with a focus on the flow of 

operations. Follow the measurement procedures outlined below for practice in operating the 

CD spectrometer. Refer to Chapter 6 “Measurment Program Reference” for details about 

toolbar icons and menus, and to Chapter 7 “[Spectra Measurement] Program Menu Reference” 

for details about the [Parameters...] command. 

4.1 Procedures for the [Spectra Measurement] Program 
This section describes procedures ranging from measuring a CD spectrum of an ammonium 

d-10-camphorsulfonate solution to saving and printing the measurement data. 

Starting the [Spectra Measurement] Program   Refer to Section 4.2 

↓ 

Specifying and Saving Measurement Parameters   Refer to Section 4.3 

↓ 

Reviewing and Approving the Parameter File*   Refer to Section 4.4 

↓ 

Measuring the Sample      Refer to Section 4.5 

↓ 

Saving Spectra*       Refer to Section 4.6 

↓ 

Printing Results       Refer to Section 4.7 

↓ 

Exiting the Program      Refer to Section 4.8 

*The step in section 4.4 is only for the CFR version and 4.6 is only for the non CFR version 

Note 1: In the CFR version, Managers or Analysts authority is required to specify 

measurement parameters. 

Note 2: In the CFR version, measurement can basically be performed using only reviewed 

and approved measurement parameters. However, only the person who created 

parameter file can perform measurement without review and approval. 

 

Figure 4.1 Message when measurement is attempted using unapproved and unsigned 

measurement parameters 
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4.2 Starting the [Spectra Measurement] Program 

To start the program, double-click [Spectra Measurement] from the [Instrument] list of [Spectra 

Manager CFR]. The window in Figure 4.2 is displayed. 

 

Figure 4.2 [Spectra Measurement] window 

Note: In the CFR version, if [Monitor] is deselected in the [System Policy Settings] dialog 

box in the [Administrative Tools] program, “Off” is displayed in the monitor bar of the 

program main window. This setting can be selected only by users with [Spectra 

Manager CFR] Administrator privileges. For details about this setting, refer to the 

[System Policy Settings...] section in the instruction manual for the [Spectra Manager 

Ver.2.5 CFR Administrative Tools] program. 

  

Figure 4.3 Clearing [Monitor] in [System Policy Settings] dialog box and displaying Off in the 

monitor bar in the CFR version 
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4.3 Specifying and Saving Measurement Parameters 

(1) Select [Parameters...] from the [Measure] menu (or click the  button) to display the 

dialog box in Figure 4.4. The [Parameters] dialog box contains the [General], [Control], 

[Information], and [Data] tabs. The [General] tab is open by default in the [Parameters] 

dialog box. The page can be changed by clicking each tab at the top of the dialog box. 

Notes: In the CFR version,  

1. Managers or Analysts authority is required to specify parameters. 

2. In order to perform a measurement by users with Operators authority, a measurement 

parameter file with an approval signature is required. 

3. Table 4.1 lists the privileges of different users with regard to inspection 
parameter files. 

Table 4.1 Parameter file signature status and user privileges to perform measurements 

Inspection parameter file Measurement 

Creation Review Approval 

Managers Analysts Operators Managers 

Analysts 

Managers 

Analysts 

Managers 

◼ □ □ 

Possible 

(Only with creator's 

own parameter file) 

Possible 

(Only with creator's 

own parameter file) 

Impossible 

◼ ◼ □ Impossible Impossible Impossible 

◼ ◼ ◼ Possible Possible Possible 

◼: Signed, □: Not signed 

The parameters can be switched between two modes: Basic mode and Advanced 

mode. In Basic mode, the choice of parameters is partially limited. In Advanced mode, 

each parameter is specified individually. The parameters described in this section are 

specified in Basic mode. To switch between Basic and Advanced modes, click the 

<Basic Mode> or <Advanced Mode> button. 
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(2) Specify the measurement parameters in the [General] tab as follows. 

 

Figure 4.4 [General] tab in [Parameters] dialog box 
 

Photometric mode  

[Channels Num] 2 

[Channel 1] [CD] 

[Channel 2] [HT] 

[CD scale] 200 mdeg/1.0 dOD 

[FL scale] 200 mdeg/1.0 dOD 

[D. I. T.] 2 sec 

[Bandwidth] 1 nm 

[Start] 350 nm 

[End] 220 nm 

[Data pitch] 0.1 nm  

[Start mode] [Immediately] 

[Scanning mode] [Continuous] 

[Scanning speed] 100 nm/min 

Accumulation/cycle  

[Accumulation] Deselected 

[No. of accumulations] 1 

Note: Select the appropriate [CD scale] for the sample to be measured. 
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Parameters can be set by using two methods: selecting from available options and 

specifying numeric values and characters. An example of setting parameters by using 

each method is given below. 

1) Selecting from available options 

The following example describes how to select the CD scale. Select the CD scale from 

the available options in the [CD scale] drop-down list. Click the arrow to the right of the 

box to display the full list of [CD scale] options (see Figure 4.5). Select the desired CD 

scale (in this example, 200 mdeg/1.0 dOD). 

 

Figure 4.5 [CD scale] drop-down list 

2) Specifying numeric values and characters 

The following example describes how to specify the start wavelength. Click the [Start] 

text box to edit the start wavelength. When the cursor appears in the text box, values 

can be entered. Type the desired wavelength (in the example in Figure 4.4, 350 nm) in 

the text box to set the start wavelength. 
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(3) Specify the measurement parameters in the [Control] tab as follows. 

 

Figure 4.6 [Control] tab in [Parameters] dialog box 

Correction [None] 

[Shutter is opened and closed automatically] Selected 

[Shutter is closed between measurements.] Deselected 
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(4) Click the [Information] tab. Type information in the [Sample name], [Username], 

[Division], [Comment], [Concentration] and [Solvent] text boxes as desired. The 

information entered here is saved as comment information together with the spectral 

data when the spectra are saved. 

 

Figure 4.7 [Information] tab in [Parameters] dialog box 

[Sample name] Enter as desired (maximum 63 characters). 

[Username] Enter a username (maximum 63 characters). 

[Division] Enter a division name for the operator (maximum 127 

characters). 

[Comment] Enter a comment (maximum 127 characters). 

[Concentration] Enter a sample concentration. 

[Solvent] Enter a solvent name (maximum 127 characters). 

[Display the [Comments] 

dialog box before 

measurement] 

Deselected 

Note: In the CFR version, the [Username] and [Division] text boxes cannot be changed by 

the user. 

 



 

46 

(5) Click the [Data] tab. Specify the [Save data], [Send data], and [Print] options for the 

measured spectrum. In this example, select the [To Spectra Analysis] check box. 

 

Figure 4.8 [Data] tab in [Parameters] dialog box 

[To Spectra Analysis] Selected 

[Print data after measurement] Deselected 

Note : In the CFR version, all measurement data must be saved. Select the folder specified 

for the workgroup that the user belongs to, or a subfolder. 
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(6) In the CFR version, always save changes to the parameters. Click the <Save...> button 

to display the dialog box in Figure 4.9. 

 
Figure 4.9 [Save Parameters] dialog box 

(7) After entering the file name, type a password and then click the <Save> button. 

Note: In the CFR version, when the parameters have not been saved, the following 

message is displayed. 

 

Figure 4.10 Message when an attempt was made to close the parameter file without saving it 
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4.4 Reviewing and Approving the Parameter File 

Note: In the CFR version, Managers or Analysts authority is required for the review 

signature, and Managers authority is required for the approval signature. Log on to 

[Spectra Manager] as a user who has authority to provide a signature. 

(1) Click [Spectra Measurement] in the [Instrument] list of [Spectra Manager CFR]. 

(2) Select [Parameter Files (*.cdspp)] in the [Files of type] drop-down list to display the file 

name of a saved calibration curve. Clicking the calibration file name displays the 

[Information], [History], and [Signature] tabs. Click the [Signature] tab. 

  
Figure 4.11 Assigning signatures to parameter file 

(3) Select the [Review] and/or [Approval] check boxes, type the password, and then click 

the <Sign> button. 

  

File name of a saved 

parameter file 

[Signature] tab 
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(4) Start the [Spectra Measurement] program, set the data mode and select [Open 

Parameters...] from the [File] menu. The dialog box in Figure 4.12 is displayed. 

 
Figure 4.12 [Open Parameters] dialog box 

Note: In the CFR version, a folder higher than a workgroup folder cannot be used. However, 

a subfolder within a prespecified workgroup folder can be selected. 

(5) Select a parameter file and click the <Open> button. The parameter file opens in the 

[Spectra Measurement] window. 
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4.5 Measuring the Sample 

(1) Inserting the sample 

Fill the cell with the sample, place it in the cell holder, and then close the lid of the sample 

compartment. 

(2) Measuring the sample 

Select [Sample Measurement] from the [Measure] menu (or click the  button) to 

measure the spectrum for the sample. In the CFR version, the dialog box shown in Figure 

4.13 is displayed at the start of the measurement. Type a password, and then click the 

<OK> button. The progress of the measurement is displayed in the window (see Figure 

4.14). 

 

Figure 4.13 [Creation Signature (Auto Save)] dialog box 

 
Figure 4.14 [Spectra Measurement] window 
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After measurement, the [Spectra Analysis] program starts and the measured data is 

displayed in a window. This window is called a "View".  

Note 1: When the [Spectra Analysis] program is already running, it is not automatically 

displayed as the active window after measurement. Click [Spectra Analysis] on the 

Windows task bar to display the program as the active window. 

Note 2: Data is not automatically transferred unless the [To Spectra Analysis] check box is 

selected in the [Data] tab of the [Parameters] dialog box. To transfer data, select 

[Send to Analysis] from the [File] menu (or click the  button). 

 
Figure 4.15 Spectrum View 
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4.6 Saving Spectra 
This section describes the procedure for saving spectra using the [Spectra Analysis] program. 

In the CFR version, since all measurement data are always saved, the steps in this section are 

not required. 

Note: Spectra can also be saved by selecting [Save Data...] from the [File] menu (or by 

clicking the  button) in the [Spectra Measurement] program. 

(1) Select [Save As...] from the [File] menu in the [Spectra Analysis] program to display the 

dialog box in Figure 4.16. 

 
Figure 4.16 [Save As] dialog box 

(2) From the [Save in] drop-down list, select the folder in which to save the spectrum. 

(3) Type the file name in the [File name] text box. In this example, type “d-10-ACS” as the 

file name. 

(4) After entering the file name, type a password and then click the <Save> button. 

(5) The file name is appended with the extension “.jws” (“d-10-ACS.jws”), which is the 

standard file type. 

(6) After saving the data, the title bar of the View changes to “View (d-10-ACS.jws)”. 
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4.7 Printing Results 
Print the measured spectra using a connected printer as follows. 

 

(1) Select [Print Setup...] from the [File] menu to display the dialog box in Figure 4.17. The 

content of this dialog box varies depending on the connected printer. Configure the 

printer settings if necessary. 

 
Figure 4.17 Example of [Print Setup] dialog box 

(2) Select [Print...] from the [File] menu to print the data. 

Note: Refer to the [Spectra Analysis] program manual for details about printing a spectrum. 
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4.8 Exiting the Program 

(1) Exiting the [Spectra Analysis] program 

Select [Exit] from the [File] menu. The [Spectra Analysis] window closes, leaving the 

[Spectra Measurement] window displayed. 

Note: When there are unsaved spectra in the window, a warning message is displayed. 

Perform the action recommended by the message. A message is displayed for each 

unsaved spectrum. 

 

Figure 4.18 Message when data has not been saved 

(2) Exiting the [Spectra Measurement] program 

Select [Exit] from the [File] menu to close the [Spectra Measurement] program, leaving 

the [Spectra Manager] window displayed. 

(3) Exiting the [Spectra Manager] program 

Select [Exit] from the [Program] menu. 

(4) Exiting Windows 

Exit Windows in accordance with standard Windows operation procedures. 

(5) Turning off the PC and CD spectrometer 

First, turn off the PC and monitor. Ensure that the sample compartment is empty, and then 

turn off the CD spectrometer. 
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5. Introduction to the [Time Course Measurement] 
Program 

This chapter describes how to use the [Time Course Measurement] program, including 

procedures for starting the [Time Course Measurement] program, measuring the spectrum of 

a sample, and saving and printing data, for practice in operating a JASCO CD spectrometer. 

Explanations of the parameters have been kept to a minimum, with a focus on the flow of 

operations. Follow the measurement procedures outlined below for practice in operating the 

CD spectrometer. Refer to Chapter 6 “Measurement Program Reference” for details about 

toolbar icons and menus, and refer to Chapter 8 “[Time Course Measurement] Program Menu 

Reference” for details about the [Parameters...] command. 

 

5.1 Procedures for the [Time Course Measurement] 
Program 

This section describes procedures ranging from measuring CD time-course data for an 

ammonium d-10-camphorsulfonate solution to saving and printing the measurement data. 

 

Starting the [Time Course Measurement] Program   Refer to Section 5.2 

↓ 

Specifying and Saving Measurement Parameters   Refer to Section 5.3 

↓ 

Reviewing and Approving the Parameter File*   Refer to Section 5.4 

↓ 

Measuring the Sample      Refer to Section 5.5 

↓ 

Saving Time-Course Data      Refer to Section 5.6 

↓ 

Printing Results       Refer to Section 5.7 

↓ 

Exiting the Program      Refer to Section 5.7 

*The step in section 5.4 is only for the CFR version and 5.6 is only for the non CFR version 
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Note 1: In the CFR version, Managers or Analysts authority is required to specify 

measurement parameters. 

Note 2: In the CFR version, measurement can basically be performed using only reviewed 

and approved measurement parameters. However, only the person who created 

parameter file can perform measurement without review and approval. 

 

Figure 5.1 Message when measurement is attempted using unapproved and unsigned 

measurement parameters 

 

5.2 Starting the [Time Course Measurement] Program 
To start the program, double-click [Time Course Measurement] from the [Instrument] list of 

[Spectra Manager CFR]. The window in Figure 5.2 is displayed. 

 
Figure 5.2 [Time Course Measurement] window 
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Note: In the CFR version, if [Monitor] is deselected in the [System Policy Settings] dialog 

box in the [Administrative Tools] program, “Off” is displayed in the monitor bar of the 

program main window. This setting can be selected only by users with [Spectra 

Manager CFR] Administrator privileges. For details about this setting, refer to the 

[System Policy Settings...] section in the instruction manual for the [Spectra Manager 

Ver.2.5 CFR Administrative Tools] program. 

  

Figure 5.3 Clearing [Monitor] in [System Policy Settings] dialog box and displaying Off in the 

monitor bar in the CFR version 

 

5.3 Specifying and Saving Measurement Parameters 

(1) Select [Parameters...] from the [Measure] menu (or click the  button) to display the 

dialog box in Figure 5.4. The [Parameters] dialog box contains the [General], [Control], 

[Information], and [Data] tabs. The [General] tab is open by default in the [Parameters] 

dialog box. The page can be changed by clicking each tab at the top of the dialog box. 

Notes: In the CFR version,  

1. Managers or Analysts authority is required to specify parameters. 

2. In order to perform a measurement by users with Operators authority, a measurement 

parameter file with an approval signature is required. 

3. Table 4.1 lists the privileges of different users with regard to inspection 
parameter files. 

The parameters can be switched between two modes: Basic mode and Advanced mode. 

In Basic mode, the choice of parameters is partially limited. In Advanced mode, each 

parameter is specified individually. The parameters described in this section are specified 

in Basic mode. To switch between Basic and Advanced modes, click the <Basic Mode> 

or <Advanced Mode> button. 
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(2) Specify the measurement parameters in the [General] tab as follows. 

 
Figure 5.4 [General] tab in [Parameters] dialog box 

Photometric mode  

[Channels Num] 2 

[Channel 1] [CD] 

[Channel 2] [HT] 

[CD scale] 200 mdeg/1.0 dOD 

[FL scale] 200 mdeg/1.0 dOD 

[D. I. T. ] 1 sec 

[Bandwidth] 1 nm 

[Wavelength] 291 nm 

[Measuring time] 60 sec 

[Data pitch] 1 sec  

[Start mode] [Immediately] 

Note: Select the appropriate [CD scale] for the sample to be measured. 
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Parameters can be set by using two methods: selecting from available options and 

specifying numeric values and characters. An example of setting parameters using each 

method is given below. 

1) Selecting from available options 

The following example describes how to select the CD scale. Select the CD scale from 

the available options in the [CD scale] drop-down list. Click the arrow to the right of the 

box to display the full list of [CD scale] options (see Figure 5.5). Select the desired CD 

scale (in this example, 200 mdeg/1.0 dOD). 

 
Figure 5.5 [CD scale] drop-down list 

2) Specifying numeric values and characters 

The following example describes how to specify the wavelength. Click the [Wavelength] 

text box to edit the wavelength. When the cursor appears in the text box, values can be 

entered. Type the desired wavelength (in the example in Figure 5.4, 291 nm) in the text 

box to set the wavelength. 
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(3) Specify the measurement parameters in the [Control] tab as follows. 

 
Figure 5.6 [Control] tab in [Parameters] dialog box 

Correction [None] 

[Shutter is opened and closed automatically] Selected 
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(4) Click the [Information] tab. Type information in the [Sample name], [Username], 

[Division], [Comment], [Concentration] and [Solvent] text boxes as desired. The 

information entered here is saved as comment information together with the time-

course data when the data are saved. 

 
Figure 5.7 [Information] tab in [Parameters] dialog box 

[Sample name] Enter as desired (maximum 63 characters). 

[Username] Enter a username (maximum 63 characters). 

[Division] Enter a division name for the operator (maximum 127 

characters). 

[Comment] Enter as desired (maximum 127 characters). 

[Concentration] Enter as desired. 

[Solvent] Enter as desired (maximum 127 characters). 

[Display the [Comments] 

dialog box before 

measurement] 

Deselected 

Note: In the CFR version, the [Username] and [Division] text boxes cannot be changed by 

the user. 
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(5) Click the [Data] tab. Specify the [Save data], [Send data], and [Print] options for the 

measured data. In this example, select the [To Spectra Analysis] check box. 

 
Figure 5.8 [Data] tab in [Parameters] dialog box 

[Auto save] Deselected 

[To Spectra Analysis] Selected 

[Print data after measurement] Deselected 

Note: In the CFR version, all measurement data must be saved. Select the folder specified 

for the workgroup that the user belongs to, or a subfolder. 
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(6) In the CFR version, always save changes to the parameters. Click the <Save...> button 

to display the dialog box in Figure 5.9. 

 
Figure 5.9 [Save Parameters] dialog box 

(7) After entering the file name, type a password and then click the <Save> button. 

Note: When the parameters have not been saved, the following message is displayed. 

 

Figure 5.10 Message when the parameters have not been saved 
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5.4 Reviewing and Approving the Parameter File 

Note : In the CFR version, Managers or Analysts authority is required for the review 

signature, and Managers authority is required for the approval signature. Log on to 

[Spectra Manager] as a user who has authority to provide a signature. 

(1) Click [Time Course Measurement] in the [Instrument] list of [Spectra Manager CFR]. 

(2) Select [Parameter Files (*.cdtm)] in the [Files of type] drop-down list to display the file 

name of a saved calibration curve. Clicking the calibration file name displays the 

[Information], [History], and [Signature] tabs. Click the [Signature] tab. 

  
Figure 5.11 Assigning signatures to parameter file 

(3) Select the [Review] and/or [Approval] check boxes, type the password, and then click 

the <Sign> button. 

File name of a saved 

parameter file 

[Signature] tab 
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(4) Start the [Time Course Measurement] program, set the data mode and select [Open 

Parameters...] from the [File] menu. The dialog box in Figure 5.12Figure 4.12 is displayed. 

 
Figure 5.12 [Open Parameters] dialog box 

Note: In the CFR version, a folder higher than a workgroup folder cannot be used. However, 

a subfolder within a prespecified workgroup folder can be selected. 

(5) Select a parameter file and click the <Open> button. The parameter file opens in the 

[Spectra Measurement] window. 
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5.5 Measuring the Sample 

(1) Inserting the sample 

Fill the cell with the sample, place it in the cell holder, and then close the lid of the sample 

compartment. 

(2) Measuring the sample 

Select [Sample Measurement] from the [Measure] menu (or click the button) to 

measure the time-course data for the sample. In the CFR version, the dialog box shown 

in Figure 5.13 is displayed at the start of the measurement. Type a password, and then 

click the <OK> button. The progress of the measurement is displayed in the window (see 

Figure 5.14). 

 

Figure 5.13 [Creation Signature (Auto Save)] dialog box 

 
Figure 5.14 [Spectra Measurement] window 
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After measurement, the [Spectra Analysis] program starts and the measured data is 

displayed in the window. This window is called a "View". 

Note 1: When the [Spectra Analysis] program is already running, it is not automatically 

displayed as the active window after measurement. Click [Spectra Analysis] on the 

Windows task bar to display the program as the active window. 

Note 2: Data is not automatically transferred unless the [To Spectra Analysis] check box is 

selected in the [Data] tab of the [Parameters] dialog box. To transfer data, select 

[Send to Analysis] from the [File] menu (or click the  button). 

 
Figure 5.15 Spectrum View 
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5.6 Saving Time-Course Data 
This section describes the procedure for saving time-course data using the [Spectra Analysis] 

program. In the CFR version, since all measurement data are always saved, the steps in this 

section are not required. 

Note: Data can also be saved by selecting [Save Data...] from the [File] menu (or by clicking 

the  button) in the [Spectra Measurement] program. 

(1) Select [Save As...] from the [File] menu in the [Spectra Analysis] program to display the 

dialog box in Figure 5.16. 

 
Figure 5.16 [Save As] dialog box 

(2) From the [Save in] drop-down list, select the folder in which to save the data. 

(3) Type the file name in the [File name] text box. In this example, type “d-10-ACS” as the 

file name. 

(4) After entering the file name, type a password and then click the <Save> button. 

(5) The file name is appended with the extension “.jws” (“d-10-ACS.jws”), which is the 

standard file type. 

(6) After saving the data, the title bar of the View changes to “View (d-10-ACS.jws)”. 
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5.7 Printing Results 
Print the measured spectra using a connected printer as follows. 

 

(1) Select [Print Setup...] from the [File] menu to display the dialog box in Figure 5.17. The 

content of this dialog box varies depending on the connected printer. Configure the 

printer settings if necessary. 

 

Figure 5.17 Example of [Print Setup] dialog box 

(2) Select [Print...] from the [File] menu to print the data. 

Note: Refer to the [Spectra Analysis] program manual for details about printing a spectrum. 
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5.8 Exiting the Program 

(1) Exiting the [Spectra Analysis] program 

Select [Exit] from the [File] menu. The [Spectra Analysis] window closes, leaving the 

[Spectra Measurement] window displayed. 

Note: When there are unsaved data in the window, a warning message is displayed. 

Perform the action recommended by the message. A message is displayed for each 

unsaved set of data. 

 

Figure 5.18 Message when data have not been saved 

 

(2) Exiting the [Time Course Measurement] program 

Select [Exit] from the [File] menu to close [Time Course Measurement], leaving the 

[Spectra Manager] window displayed. 

 

(3) Exiting the [Spectra Manager] program 

Select [Exit] from the [Program] menu. 

 

(4) Exiting Windows 

Exit Windows in accordance with standard Windows operation procedures. 

 

(5) Turning off the PC and CD spectrometer 

First, turn off the PC and monitor. Ensure that the sample compartment is empty, and then 

turn off the CD spectrometer. 
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6. Measurement Program Reference 
This chapter describes common toolbar and menu commands for the [Spectra measurement], 

[Time Course Measurement] and [Data Monitor] programs. Refer to Chapters 7 to 9 or the 

[Help] menu for details about specific parameters for each measurement program. 

Note 1: Refer to Table 6.1 for information about the availability of toolbar and menu 

commands in the three programs. 

Note 2: All toolbar and menu commands are not necessarily available for every program. 

Note3: In the CFR version, the [Data Monitor] program is not available. 

The [Spectra Measurement] program reference describes the features of the [Spectra 

Measurement] program for measuring a sample spectrum. 

 

6.1 Overview of Measurement Programs 
Starting the measurement program displays the window in Figure 6.1. 

 
Figure 6.1 Measurement program window ([Spectra Measurement]) 

 

 

Monitor bar 

Displays the current wavelength,  

number of cycles or number of 

accumulations and photometric values. 

Toolbar 

Measurement , parameter settings can be set and 

other common functions can be performed using the 

buttons on this toolbar (see Table 6.1). These tool 

buttons can be customized in the [Settings] menu. 

Data display field 

Displays the data being measured. The 

display format can be specified using the 

[View] menu. 

Accessory bar 

Displays information about attached 

accessories. Some accessories can be 

controlled from this bar. 

Information bar 

Displays the current measurement 

parameters. 

Main unit bar 

Displays current detector 

and alarm information for J-

1000. Detectors can be 

controlled from this bar. 
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Table 6.1 Toolbar buttons and names 

Button Name Reference Section Spectra 

Measurement 

Time Course 

Measurement 

Data 

Monitor 

 
[Save] 6.2.1 [Save Data...] 

Note: In the CFR version, 

this function is not 

available. 

✔ ✔  

 
[Send to Analysis] 6.2.2 [Send to Analysis] ✔ ✔  

 
[Open Parameters] 6.2.3 [Open Parameters...] ✔ ✔  

 
[Save Parameters] 6.2.4 [Save Parameters...] 

Note: In the CFR version, 

this function is not 

available. 

✔ ✔  

 
[Cancel] 6.3.1 [Cancel] ✔ ✔  

 
[Sequence 

Measurement] 

6.3.2 [Sequence Measurement] ✔ ✔  

 
[Sample 

Measurement] 

6.3.3 [Sample Measurement] ✔ ✔  

 
[Blank/Baseline 

Measurement] 

6.3.4 [Baseline Measurement] 

6.3.5 [Blank Measurement] 

✔ ✔  

 
[Dark 

Measurement] 

6.3.6 [Dark Measurement] ✔ ✔  

 
[Parameters] 6.3.7 [Parameters...] ✔ ✔ ✔ 

 
[Zero Clear] 6.4.1 [Zero Clear] ✔ ✔ ✔ 

 
[Shutter] 6.4.2 [Shutter...] ✔ ✔ ✔ 

 
[Move Wavelength] 6.4.3 [Move Wavelength...] ✔ ✔ ✔ 

 
[Detector] 6.4.4 [Detector...] ✔ ✔ ✔ 

 

 

[Xe Lamp] 

[WI Lamp] 

6.4.5 [Light Source...] 

Note: Turns the xenon 

lamp on or off. 

✔ ✔ ✔ 

 
[Hg Lamp] 6.4.5 [Light Source...] 

Note: Turn off the Hg 

lamp. 

✔ ✔ ✔ 

 
[Scales] 6.5.1 [Scales...] ✔ ✔  

 
[Patterns] 6.5.2 [Patterns...] ✔ ✔ ✔ 

 
[Fonts] 6.5.3 [Fonts ...] ✔ ✔ ✔ 

 
[Gridlines] 6.5.4 [Gridlines...] ✔ ✔ ✔ 
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[Styles] 6.5.5 [Styles...] ✔ ✔ ✔ 

 
[Digital] 6.5.12 [View Mode]   ✔ 

 
[Graph] 6.5.12 [View Mode]   ✔ 

 

Window 

Title bar Displays the program name. 

Menu bar Displays the menus for operation. 

Monitor bar Displays from left to right the current wavelength, number 

of cycles or number of accumulations and photometric 

values. 

Toolbar Displays available tool buttons. These tool buttons can be 

customized in the [Settings] menu. 

Information bar Displays the current measurement parameters. 

Main unit bar Displays current detector information and alarm information 

for the J-1000 CD spectrometer. 

Accessory bar Displays information about the attached accessory. 

Spectrum display field Displays the spectrum or time-course data being measured. 

Status bar Displays the current state of the instrument and an 

explanation of the selected menu. 

Menu 

[File] menu Spectra 

Measure-

ment 

Time 

Course 

Measure-

ment 

Data 

Monitor 

[Save Data...] Saves the spectrum with a new file 

name. 

Note: In the CFR version, this 

function is not available. 

✔ ✔  

[Send to Analysis] Transfers the measured data to the 

[Spectra Analysis] program. 

✔ ✔  

[Open 

Parameters...] 

Selects a parameter file and opens 

those parameters. 

✔ ✔  

[Save 

Parameters...] 

Saves the currently specified 

measurement parameters with the 

entered file name. 

Note: In the CFR version, this 

function is not available. 

✔ ✔  

[Open Baseline...] Selects a baseline file and opens that 

baseline spectrum. 

Note: In the CFR version, this 

function is not available. 

✔   
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[Save Baseline...] Saves the currently measured 

baseline spectrum with the entered 

file name. 

Note: In the CFR version, this 

function is not available. 

✔   

[Exit]  Exits the measurement program and 

returns to [Spectra Manager]. 

Note: This command is in the 

[Measure] menu in the 

[Data Monitor] program. 

✔ ✔ ✔ 

[Measure] menu    

[Cancel] Cancels the measurement. ✔ ✔  

[Sequence 

Measurement] 

Executes the sequence. ✔   

[Sample 

Measurement] 

Measures the spectrum or time-

course data for the sample. 

✔ ✔  

[Baseline 

Measurement] 

Measures the baseline spectrum for 

baseline correction. 

✔   

[Blank 

Measurement] 

Measures the blank for blank 

correction. 

 ✔  

[Dark 

Measurement] 

Measures the dark spectrum for dark 

correction. 

✔ ✔  

[Parameters...] Specifies parameters and saves or 

opens the measurement parameters. 

✔ ✔ ✔ 

[Control] menu    

[Zero Clear] Sets the photometric value of ORD-M 

or fluorescence intensity at the 

current wavelength to zero. 

✔ ✔ ✔ 

[Shutter...] Opens/closes the shutter. ✔ ✔ ✔ 

[Move 

Wavelength...] 

Moves the CD spectrometer 

wavelength to the desired 

wavelength. 

✔ ✔ ✔ 

[Detector...] Sets the detector sensitivity. ✔ ✔ ✔ 

[Light Source] Turns on or off the xenon lamp. ✔ ✔ ✔ 

[Nitrogen 

Flowrate...] 

Specifies the flow rate of nitrogen 

gas. This command is only displayed 

when [Automatic (PC control)] is 

selected for the nitrogen flow meter. 

✔ ✔ ✔ 

[Select Detector...] Selects a detector. ✔ ✔ ✔ 

[Select 

Accessory...] 

Selects an accessory. ✔ ✔ ✔ 
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[View] menu    

[Scales...] Specifies the display scale for the 

spectrum or time-course data. 

✔ ✔  

[Patterns...] Selects the display color and line style 

for the spectrum or time-course data. 

✔ ✔  

[Fonts...] Specifies the display font for the 

spectrum or time-course data. 

✔ ✔  

[Gridlines...] Shows/hides the gridlines for the 

spectrum or time-course data. 

✔ ✔  

[Styles...] Specifies the display style for the 

spectrum or time-course data. 

✔ ✔  

[Overlay] Overlays spectra or time-course data 

when cycle measurement is selected. 

✔ ✔  

[Select Graph...] Selects the graph to be displayed on 

the CD spectrum display field. 

✔ ✔  

[Information Bar] Shows/hides the information bar. ✔ ✔ ✔ 

[Accessory Bar] Shows/hides the accessory bar. ✔ ✔ ✔ 

[Toolbars] Shows/hides toolbars. ✔ ✔ ✔ 

[Status Bar] Shows/hides the status bar. ✔ ✔ ✔ 

[View Mode] Displays the photometric value in 

digital or graph mode. 

  ✔ 

[Graph View] Selects the graph to be displayed 

when graph mode is selected for the 

photometric value display. 

  ✔ 

[Settings] menu    

[Default 

Parameters...] 

Specifies measurement parameters 

for running the [Spectra 

Measurement] and [Time Course 

Measurement] programs based on 

the currently recognized accessory. 

Note: In the CFR version, this 

function is not available. 

✔ ✔  

[Customize 

Toolbar...] 

Customizes and shows/hides 

toolbars. 

✔ ✔ ✔ 

[Monitor Bar...] Customizes the style of the monitor 

bar. 

✔ ✔ ✔ 

[Help] menu    

[About...] Displays version information for the 

program. 

✔ ✔ ✔ 
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6.2 [File] Menu 
Saves or opens a measured data or parameter file. 

 

6.2.1 [Save Data...] 

Saves the measured data with a new file name. 

Note 1: This operation can also be performed by clicking the tool button  [Save]. 

Note 2: In the CFR version, since all measurement data are always saved, this function is not 

available. 

 
Figure 6.2 [Save data] dialog box 

[Save in] list Selects a drive or folder to browse using the drop-down list. Files 

saved in the currently opened folder are displayed in the file name 

list. 

File name list Lists the files in the currently opened folder. Use as a reference 

when naming a file. 

[File name] Enters a file name for saving the measured data. 

An extension may be omitted. 

[Save as type] Selects the files (type of extension) to display in the file name list. 

Files other than Standard Files (*.jws) cannot be selected. 

<Save> Saves the measured data and closes the dialog box. 

<Cancel> Closes the dialog box without saving the measured data. 

  



 

77 

6.2.2 [Send to Analysis] 

Transfers the measured data to the [Spectra Analysis] program. Selecting the [To Spectra 

Analysis] check box in the [Data] tab of the [Parameters] dialog box from the [Measure] menu 

automatically transfers the measured spectrum to the [Spectra Analysis] program after 

measurement. 

When a value of 2 or more is specified for the number of cycles in the [Parameters] dialog box, 

the dialog box in Figure 6.3 is displayed. 

 
Figure 6.3 [Send to Analysis] dialog box 

Select the check boxes for the data to send to the [Spectra Analysis] program (or click the 

<Select All> button to send all data), and then click the <OK> button.  

Note: This operation can also be performed by clicking the tool button  [Send to 

Analysis]. 
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6.2.3 [Open Parameters...] 

Selects a parameter file and opens those parameters. 

Note 1: This operation can also be performed by clicking the tool button  [Open 

Parameters]. 

Note 2: The dialog box in Figure 6.4 displays only the parameter files for the currently attached 

accessory. 

 
Figure 6.4 [Open Parameters] dialog box 

[Look in] list Selects a drive and folder to browse using the drop-down list. 

Files saved in the currently opened folder are displayed in the file 

name list. 

File name list Lists the files in the currently opened folder. Selects the file name 

of the parameters to open. 

[File name] Enters the file name for the parameters to open. 

An extension may be omitted since the appropriate extension for 

the measurement program is automatically appended. 

[Files of type] Selects the files (type of extension) to display in the file name list. 

Files other than Parameter Files (having the appropriate 

extension for the measurement program) cannot be selected. 

<Open> Opens a parameter file and closes the dialog box. 

<Cancel> Closes the dialog box without opening a parameter file. 

Note: In the CFR version, the [Look in] drop-down list cannot be used to select a folder. 

However, a subfolder within the prespecified folder can be selected. 
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6.2.4 [Save Parameters...] 

Saves the currently specified measurement parameters with the entered file name. 

Note1: This operation can also be performed by clicking the tool button  [Save 

Parameters]. 

Note2: In the CFR version, since all measurement parameters are always saved, this function 

is not available. 

 

 
Figure 6.5 [Save Parameters] dialog box 

[Save in] list Selects a drive or folder to browse using the drop-down list. Files 

saved in the currently opened folder are displayed in the file name 

list. 

File name list Lists the files in the currently opened folder. Use as a reference 

when naming a file. 

[File name] Enters a file name for saving parameters. 

An extension may be omitted since the appropriate extension for 

the measurement program is automatically appended. 

[Save as type] Selects the files (type of extension) to display in the file name list. 

Files other than Parameter Files (having the appropriate extension 

for the measurement program) cannot be selected. 

<Save> Saves the parameter file and closes the dialog box. 

<Cancel> Closes the dialog box without saving the parameter file. 
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6.2.5 [Open Baseline...] 

Selects a baseline file and opens that baseline. When a baseline file is opened, the sample 

spectrum is corrected by using the opened baseline spectrum. 

Note 1: In the CFR version, this function is not available. 

Note 2: The following dialog box displays only the baseline files for the currently attached 

accessory. 

Note3: This function is available if [Baseline] is selected in the [Control] tab of the 

[Parameters] dialog box. 

 
Figure 6.6 [Open Baseline] dialog box 

Click the  <Preview> button in Figure 6.6 to display the spectrum of the selected baseline 

file (seeFigure 6.7). 
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Figure 6.7 [Open Baseline] dialog box 

[Look in] list Selects a drive or folder to browse using the drop-down list. Files 

saved in the currently opened folder are displayed in the file name 

list. 

File name list Lists the files in the currently opened folder. Selects the file name 

of the baseline spectrum to open. 

[File name] Enters the file name of the baseline spectrum to open. 

An extension may be omitted since the extension “.cdbsl” is 

automatically appended. 

[Files of type] Selects the files (type of extension) to display in the file name list. 

Files other than Baseline Files (*.cdbsl) cannot be selected. 

<Preview> Displays the baseline spectrum and information about the 

selected file (see Figure 6.7). 

<Open> Opens the baseline file and closes the dialog box. 

<Cancel> Closes the dialog box without opening a baseline file. 
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6.2.6 [Save Baseline...] 

Saves the currently measured baseline spectrum with the entered file name. 

Note: In the CFR version, this function is not available. 

 
Figure 6.8 [Save Baseline] dialog box 

[Save in] list Selects a drive or folder to browse using the drop-down list. Files 

saved in the currently opened folder are displayed in the file name 

list. 

File name list Lists the files in the currently opened folder. Use as a reference 

when naming a file. 

[File name] Enters a file name for saving the baseline spectrum. 

An extension may be omitted since the extension “.cdbsl” is 

automatically appended. 

[Save as type] Selects the files (type of extension) to display in the file name list. 

Files other than Baseline Files (*.cdbsl) cannot be selected. 

<Save> Saves the measured baseline spectrum and closes the dialog 

box. 

<Cancel> Closes the dialog box without saving the measured baseline 

spectrum. 
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6.2.7 [Print Setup...] 

Specifies the target printer and print parameters. The content of this dialog box varies 

depending on the connected printer. Configure the printer settings if necessary. 

 
Figure 6.9 [Print Setup] dialog box 

Printer Displays the available printers. To add a new printer, select 

[Control Panel] - [Printers] from the Windows task bar and select 

[Add Printer...]. 

Paper Selects the paper size and paper source tray. 

Orientation Selects the orientation of the paper for printing. 

<OK> Applies the changes to the [Print Setup] settings and closes the 

dialog box. 

<Cancel> Closes the dialog box without applying any changes to the [Print 

Setup] settings. 

 

6.2.8 [Exit] 

Exits the [Spectra Measurement] program. 
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6.3 [Measure] Menu 
Starts or cancels the measurement, and specifies the measurement parameters. 

 

6.3.1 [Cancel] 

Cancels the measurement. A dialog box to confirm whether to keep the measurement data is 

displayed. 

Note: This operation can also be performed by clicking the tool button  [Cancel]. 

 
Figure 6.10 [Cancel] dialog box 

<Yes> Keeps the measured spectrum. 

<No> Discards the measured spectrum. 

<Cancel> Continues the measurement. 

 

6.3.2 [Sequence Measurement] 

Executes the sequence measurement. This function is enabled when autosampler is 

connected. 

Note: This operation can also be performed by clicking the tool button  [Sequence 

Measurement]. 

6.3.3 [Sample Measurement] 

Measures the CD spectrum of the sample. Selecting the [To Spectra Analysis] check box in 

the [Data] tab of the [Parameters] dialog box from the [Measure] menu automatically transfers 

the measured data to the [Spectra Analysis] program after measurement. The measured data 

is displayed in a new View. 

Note: This operation can also be performed by clicking the tool button  [Sample 

Measurement]. 
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6.3.4 [Baseline Measurement] 

Measures the baseline spectrum for baseline correction. Available if [Baseline] is selected in 

the [Control] tab of the [Parameters] dialog box. 

Baseline correction removes the effects of solvents and additional agents other than the target 

sample. The true sample spectrum is obtained by subtracting the baseline spectrum from the 

measured spectrum. 

Confirm that the sample for baseline measurement has been inserted, and then click the 

<Measure> button. 

Note: This operation can also be performed by clicking the tool button  [Baseline 

Measurement]. 

 
Figure 6.11 [Baseline Measurement] dialog box 

<Measure> Measures the baseline spectrum for baseline correction. 

<Cancel> Closes the [Baseline Measurement] dialog box without measuring the 

baseline 

 

6.3.5 [Blank Measurement] 

Measures the blank data for blank correction. Available if [Blank] is selected in the [Control] 

tab of the [Parameters] dialog box. 

Blank correction removes the effects of solvents and additional agents other than the target 

sample. The sample signal is obtained by subtracting the blank data from the data obtained 

during measurement of the sample. 

Confirm that the blank has been inserted, and then click the <Measure> button. 

Note: This operation can also be performed by clicking the tool button  [Blank 

Measurement]. 

 
Figure 6.12 [Blank Measurement] dialog box 
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<Measure> Measures the blank spectrum for blank correction. 

<Cancel> Closes the [Blank Measurement] dialog box without measuring the 

blank. 

 

6.3.6 [Dark Measurement] 

Measures the photometric value for dark correction. Available if the InGaAs or APD detector 

is used. 

Note: This operation can also be performed by clicking the tool button  [Dark 

Measurement].  

 
Figure 6.13 [Dark Measurement] dialog box 

<Measure> Measures the photometric value for dark correction. 

<Cancel> Closes the [Dark Measurement] dialog box without measuring the dark 

current. 

 

6.3.7 [Parameters...] 

Specifies the measurement parameters. Refer to each measurement program reference. 
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6.4 [Control] menu 

6.4.1 [Zero Clear] 

Sets the photometric value of the ORD-M or fluorescence intensity to zero. Available if an 

ORD-M or fluorescence detector is connected. 

Note: This operation can also be performed by clicking the tool button  [Zero Clear]. 

6.4.2 [Shutter] 

Opens/closes the shutter. 

Note: This operation can also be performed by clicking the tool button  [Shutter]. 

6.4.3 [Move Wavelength...] 

Moves the wavelength of the CD spectrometer to the desired wavelength. When the 

measurement is started, data acquisition begins once the wavelength returns to the value 

specified in [Parameters]. 

 
Figure 6.14 [Move Wavelength] dialog box 

[Move to] Specifies the wavelength. 

J-1100: 180 to 600 nm 

J-1500: 163 to 1600 nm 

J-1700: 163 to 2500 nm 

<OK> Moves the wavelength of the CD spectrometer to the specified 

wavelength and closes the dialog box. 

<Cancel> Closes the dialog box without applying any changes to the [Move 

Wavelength] settings. 

Note: This operation can also be performed by clicking the tool button  [Move 

Wavelength]. 
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6.4.4 [Detector ...] 

Specifies the sensitivity for monitoring the photometric value. 

  
Figure 6.15 [Detector Control] dialog box (left: PMT, APD) (right: InGaAS, InSb) 

Display  

[HT] Displays the HT voltage for the detector. 

[DC] Displays the DC voltage for the detector. 

[HT volt mode]  

[Auto] Automatically sets the applied voltage for the photomultiplier tube. 

[Manual] Manually sets the applied voltage for the photomultiplier tube. 

[Off] Sets the detector voltage off. 

[HT voltage] Specifies the photomultiplier tube voltage when [Manual] is selected 

for [HT volt mode]. 

Setting range: 0 to 1000 V 

[Gain] Selects the voltage gain for the InGaAs or InSb detector. 

Options: ×1, ×10, ×100 

<Apply> Sets the sensitivity of the CD spectrometer to the specified 

sensitivity. 

<Cancel> Closes the dialog box without applying any changes to the [Detector 

Control] settings. 

Note: This operation can also be performed by clicking the tool button   
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6.4.5 [Light Source...] 

Turn on/off the light source. 

 
Figure 6.16 [Light Source Control] dialog box J-1100/1500 (left) J-1700 (right) 

Note 1: This operation can also be performed by clicking the tool button  [Light 

Source]. 

Note 2: The tool button   [Mercury lamp] is available to turn off only. 

6.4.6 [Nitrogen Flowrate...] 

Controls the nitrogen gas flow rate. Available if a PC-controlled nitrogen-gas auto flow meter 

is selected. 

Note: Refer to the software manual “J-1000 series Nitrogen Flowmeter” for detail. 

6.4.7 [Select Detector...] 

Recognizes a detector manually. Select the detector to use and click the <OK> button. A 

dialog box stating “Connecting to the detector...” is displayed. 

 
Figure 6.17 [Select Detector] dialog box  
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6.4.8 [Select Accessory...] 

Selects an accessory (cell unit, external accessories or measurement units) to be used. After 

clicking the <OK> button, the message "The accessory was attached successfully.“ is 

displayed. 

 
Figure 6.18 [Select Accessory] dialog box 

Note: In the CFR version, the function for automatically starting registered programs for 

accessories is not provided. 
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6.4.9 [Accessory Model Number] 

When an accessory that has been registered is attached, the accessory name is displayed as 

a command on the [Control] menu (see Figure 6.19). Select the command to control the 

attached accessory. 

 
Figure 6.19 [Control] dialog box  

Note 1: Use this function to return the temperature of the Peltier device to room temperature 

after measuring data at high or low temperatures to set a target temperature after 

inserting a sample. 

Note 2: This operation can also be performed by clicking the <Setting...> button in the 

accessory bar. 

Accessory model 

number 
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6.5 [View] Menu 
Specifies the view options. 

 

6.5.1 [Scales...] 

Specifies the display scale for the spectrum. 

 
Figure 6.20 [Scales] dialog box 

[Frame number] Selects the graph for which to change the scales. 

Horizontal axis Enters the scale for the horizontal axis. Selecting the [Auto] 

check box displays the entire range irrespective of the entered 

values. 

Vertical axis Enters the scale for the vertical axis. Selecting the [Auto] check 

box displays the graph at the optimal scale for the specified 

horizontal axis range. 

<OK> Applies the changes to the [Scales] settings and closes the dialog 

box. 

<Cancel> Closes the dialog box without applying any changes to the 

[Scales] settings. 

<Apply> Applies the specified scales to the graph selected in [Frame 

number]. 

Note: This operation can also be performed by clicking the tool button  [Scales]. 
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6.5.2 [Patterns...] 

Selects the display color and line style for the spectrum. 

 
Figure 6.21 [Patterns] dialog box 

[Item] Selects an item from spectra 1 to 16, frame, gridlines, and auxiliary 

gridlines to change its color and line style. 

[Color] Shows the available colors for the selected item in the drop-down list. 

[Line style] Shows the available line styles. The currently selected item in the 

[Item] drop-down list is displayed with the selected line style. 

[Line width] Shows the available line widths. The currently selected item in the 

[Item] drop-down list is displayed with the selected line width. 

Sample Displays a sample of the selected pattern. 

[Set as default] Applies the selected patterns to all subsequently opened Views. 

<OK> Applies the changes to the [Patterns] settings and closes the dialog 

box. 

<Cancel> Closes the dialog box without applying any changes to the [Patterns] 

settings. 

Note: This operation can also be performed by clicking the tool button  [Patterns]. 
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6.5.3 [Fonts...] 

Specifies the display font for the data. 

 
Figure 6.22 [Fonts] dialog box 

[Item] Selects an item to change its font settings. 

[Axis label]: Character ([CD (mdeg)], [nm], or other) 

[Scale label]: Numeric value 

[Font name]  Lists available font names. 

[Style]  Lists available styles. 

[Size]  Lists available sizes. 

Effects Selects strikeout and underline effects. 

[Strike out]: Draws a line through the middle of the text. 

[Underline]: Underlines the text. 

Sample Displays a sample of the specified font. 

Orientation Selects the orientation for displaying the axis label. 

[Horizontal]: Displays the y-axis label horizontally 

[Vertical]: Displays the y-axis label vertically 

[Set as default] Applies the specified fonts to all subsequently opened Views. 

[Color] Shows the available colors for the selected item in the drop-down 

list. 

[Script] Selects the language for the specified font. 

<OK> Applies the changes to the [Fonts] settings and closes the dialog 

box. 

<Cancel> Closes the dialog box without applying any changes to the [Fonts] 

settings. 

Note: This operation can also be performed by clicking the tool button  [Fonts]. 
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6.5.4 [Gridlines...] 

Shows/hides the gridlines for the data. 

 
Figure 6.23 [Gridlines] dialog box 

Main gridlines  

    [Horizontal] Displays major horizontal axis gridlines. 

    [Vertical] Displays major vertical axis gridlines. 

Auxiliary gridlines  

    [Horizontal] Displays minor horizontal axis gridlines. 

    [Vertical] Displays minor vertical axis gridlines. 

[Set as default] Applies the selected gridlines to all subsequently opened Views. 

<OK> Applies the changes to the [Gridlines] settings and closes the 

dialog box. 

<Cancel> Closes the dialog box without applying any changes to the 

[Gridlines] settings. 

Note: This operation can also be performed by clicking the tool button  [Gridlines]. 
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6.5.5 [Styles...] 

Specifies the display style for the spectrum. 

 
Figure 6.24 [Styles] dialog box 

[Axis] Selects an item to change its display style. 

Interval  

[Auto] Automatically selects the gridline format. 

[Manual] Manually specifies the gridline format for the main and auxiliary 

scales. 

Tick type  

  [None] Displays no ticks on the axis 

  [Outside] Displays ticks on the outside of the axis. 

  [Inside] Displays ticks on the inside of the axis. 

  [Cross] Displays ticks on both sides of the axis. 

[Decimal places] Selects the number of decimal places for the display values on 

the horizontal and vertical axes. 

[Display the max. and min. 

values at the main ticks] 

Displays the maximum and minimum values at the main ticks. 

Values at the auxiliary ticks are not displayed. 

[Set as default] Applies the specified styles to all subsequently opened Views. 

<OK> Applies the changes to the [Styles] settings and closes the dialog 

box. 

<Cancel> Closes the dialog box without applying any changes to the 

[Styles] settings. 

Note: This operation can also be performed by clicking the tool button  [Styles]. 
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6.5.6 [Overlay] 

Overlays the spectra in the spectrum measurement display field when cycle measurement is 

selected. 

 

6.5.7 [Select Graph...] 

Selects the graphs to display in the data display field. 

 
Figure 6.25 [Select Graph to Show] dialog box 

[Graph 1] Displays the graph for photometric mode 1 as graph 1 in the data display 

field. 

[Graph 2] Displays the graph for photometric mode 2 as graph 2 in the data display 

field. 

[Graph 3] Displays the graph for photometric mode 3 as graph 3 in the data display 

field. 

[Graph 4] Displays the graph for photometric mode 4 as graph 4 in the data display 

field. 

<OK> Selects the graphs to display and closes the dialog box. 

<Cancel> Closes the dialog box without selecting a graphs to display. 

 

6.5.8 [Information Bar] 

Shows/hides the information bar. 

 

6.5.9 [Accessory Bar] 

Shows/hides the accessory bar. 

 

6.5.10 [Toolbars] 

Shows/hides toolbars. 

 

[File] Shows/hides the toolbar corresponding to the [File] menu. 

[Measure] Shows/hides the toolbar corresponding to the [Measure] menu. 

[Control] Shows/hides the toolbar corresponding to the [Control] menu. 

[View] Shows/hides the toolbar corresponding to the [View] menu. 

 

6.5.11 [Status Bar] 

Shows/hides the status bar. 
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6.5.12 [View Mode] 

Displays the photometric value in digital or graph mode in the photometric value monitor. 

 
Figure 6.26 Digital mode of the photometric value monitor 

 
Figure 6.27 Graph mode of the photometric value monitor 
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6.5.13 [Graph View] 

Specifies [Patterns], [Fonts], [Gridlines] and [Styles] when graph mode is selected for the 

photometric value monitor. Refer to Sections 6.5.2 [Patterns...], 6.5.3 [Fonts...], 6.5.4 

[Gridlines...] and 6.5.5 [Styles...] for details about setting each command. 

 

6.6 [Settings] Menu 

6.6.1 [Default Parameters...] 

Note: In the CFR version, this function is not available. 

Specifies measurement parameters for running the measurement program based on the 

currently recognized accessory. Default parameters can be specified for each accessory. 

Attach the accessory to be used and specify its default parameters. 

 
Figure 6.28 [Default Parameters] dialog box 

[Open the most recently used 

parameters] 

Starts with the parameters previously specified before 

exiting the measurement program. 

[Open the specified parameter 

file] 

Starts with a specified parameter file. 

[File name] Displays the name of path to the parameter file when the 

[Open the specified parameter file] option button is 

selected. 

<Browse...> Selects the drive and file name for a saved parameter file 

(see Figure 6.29). 

<OK> Applies the changes to the [Default Parameters] settings 

and closes the dialog box. 

<Cancel> Closes the dialog box without applying any changes to the 

[Default Parameters] settings. 
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Figure 6.29 [Select Parameters] dialog box (when <Browse...> is clicked in [Default 

Parameters])  

6.6.2 [Customize Toolbar...] 

Customizes and shows/hides toolbars. 

 
Figure 6.30 [Edit Toolbar] dialog box 

[File] Shows/hides the toolbar corresponding to the [File] menu and 

adds/removes the following tool buttons. 

 

Button Name 

 
[Save] 

 
[Send to Analysis] 

 
[Open Parameters]] 

 
[Save Parameters] 
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[Measurement] Shows/hides the toolbar corresponding to the [Measure] menu and 

adds/removes the following tool buttons. 

 

Button Name 

 
[Cancel] 

 
[Sequence Measurement] 

 
[Sample Measurement] 

 
[Baseline Measurement]/ 

[Blank Measurement] 

 
[Dark Measurement] 

 
[Parameters] 

 

[Control] Shows/hides the toolbar corresponding to the [Control] menu and 

adds/removes the following tool buttons. 

 

Button Name 

 
[Auto Zero] 

 
[Shutter] 

 
[Move Wavelength] 

 
[Sensitivity] 

 
[Light Source][Hg Lamp] 

 

[View] Shows/hides the toolbar corresponding to the [View] menu and 

adds/removes the following tool buttons. 

 

Button Name 

 
[Scales] 

 
[Patterns] 

 
[Fonts] 

 
[Gridlines] 

 
[Styles] 

 [Digital] 

 [Graph] 
 

[Display button text] Displays the button name under each tool button. 

<Customize...> Displays the dialog box for customizing toolbars (see Figure 6.31). 
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Figure 6.31 [Customize Toolbar] dialog box 

6.6.3 [Monitor Bar...] 

Customizes the style for the monitor bar. 

 
Figure 6.32 [Monitor Bar Style] dialog box 

[Style] Selects the style for the monitor bar. 

[Classic]:   

[Standard]:   

[Size] Selects the size for the monitor bar. 

Size: [Normal], [Large], [Extra large]  

[Background color] Selects the background color for the monitor bar when [Standard] 

is selected for [Style]. 

 

6.7 [Help] Menu 

6.7.1 [Contents] 

Displays the help window with the contents tab selected. 

6.7.2 [Search Topic] 

Displays the help window with the index tab selected. 

6.7.3 [About...] 

Displays version information for the program. 
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7. [Spectra Measurement] Program Reference 
The [Spectra Measurement] program measures the change in the sample signal intensity while 

scanning the wavelength. This chapter describes specific measurement parameters for the 

[Spectra Measurement] program. 
 

7.1 [Parameters...] 
Specifies measurement parameters. The dialog box has four tabs for parameter settings, as 

shown in Figure 7.2 [General], Figure 7.3 [Control], Figure 7.4 [Information], and Figure 7.5 

[Data]. The [General] tab is open by default in the [Parameters] dialog box. The page can be 

changed by clicking each tab at the top of the dialog box. 

The parameters can be switched between two modes: Basic mode and Advanced mode. In 

Basic mode, the choice of parameters is partially limited. In Advanced mode, each parameter 

is specified individually. 
 

<Basic Mode/Advanced 

Mode> 

Switches between Basic and Advanced modes. Advanced mode 

can only be used for J-1500. 

<Open...> Opens a measurement parameter file. 

<Save...> Saves the measurement parameters. In the CFR version, an 

electronic signature is required for saving parameters. 

<Default> Restores the parameters of the [General] and [Control] tabs to 

their default values. 

<OK> Applies the changes to the [Parameters] settings and closes the 

dialog box. 

<Cancel> Closes the dialog box without applying any changes to the 

[Parameters] settings. 

Note 1: This operation can also be performed by clicking the tool button  [Parameters]. 

Note 2: In the CFR version, Managers or Analysts authority is required to specify the 

parameters. 

Note 3: In the CFR version, when the parameters are specified or changed, a signature is 

required. Clicking the <OK> button when the parameters have not been saved 

displays the following message. 

 

Figure 7.1 Message when the signature for the parameters is missing 
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7.1.1 [General] tab 

 
Figure 7.2 (a) J-1100/1500 [General] tab in [Parameters] dialog box 

 
Figure 7.2 (b) J-1700 [General] tab in [Parameters] dialog box 
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Photometric mode Selects the desired measurement parameters for the photometric 

mode. 

[Channels Num] Selects the number of channels to display in the spectrum display field. 

Click the arrow (▼ or ▲) to select the number of channels. 

Options: 1 to 4 

[Channel n] Selects the photometric mode for each channel. Click the drop-down 

list to select the photometric mode. 

[CD scale] Selects the CD/LD range for the detector in the transmission 

configuration. 

[20 mdeg/0.05 dOD]: High sensitivity mode. Available when the 

CD range is within ±20 mdeg and the LD 

range is within ±0.05 dOD. 

[200 mdeg/1.0 dOD]: Standard sensitivity mode. Available when 

the CD range is within ±200 mdeg and the 

LD range is within ±1.0 dOD. 

[2000 mdeg/1.0 dOD]: Wide range mode. Available when the CD 

range is within ±2000 mdeg and the LD 

range is within ±1.0 dOD. 

[10000 mdeg/1.0 dOD]: Maximum range mode. Available when the 

CD range is within ±10000 mdeg and the 

LD range is within ±1.0 dOD. 

[FL scale] Selects the FDCD/FDLD range for the C detector in the fluorescence 

configuration. 

[20 mdeg/0.05 dOD]: High sensitivity mode. Available when the 

FDCD range is within ±20 mdeg and the 

FDLD range is within ±0.05 dOD. 

[200 mdeg/1.0 dOD]: Standard sensitivity mode. Available when 

the FDCD range is within ±200 mdeg and 

the FDLD range is within ±1.0 dOD. 

[2000 mdeg/1.0 dOD]: Wide range mode. Available when the 

FDCD range is within ±2000 mdeg and the 

FDLD range is within ±1.0 dOD. 

[10000 mdeg/1.0 dOD]: Maximum range mode. Available when the 

FDCD range is within ±10000 mdeg and 

the FDLD range is within ±1.0 dOD. 

Note:  [FL scale] is not displayed on the J-1100. 

[D.I.T.] Selects the data acquisition time (integration time) per point. 

J-1100: 5 msec to 8 sec 

J-1500/1700: 0.1 msec to 30 sec 

[Bandwidth] Selects the spectral bandwidth. 

J-1100: 1 nm (fixed) 

J-1500/1700: 0.01 nm to 16.00 nm 
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[Slit width] Specifies the slit width within the range from 1 to 4000 m. Selecting 

[Slit width] activates the text box for entering the slit width. 

Note:  [Slit width] is not displayed on the Basic Mode. 

[Start] Specifies the measurement start wavelength. 

J-1100: 180 to 600 nm 

J-1500: 163 to 1600 nm 

J-1700: 163 to 2500 nm 

[End] Specifies the measurement end wavelength. 

J-1100: 180 to 600 nm 

J-1500: 163 to 1600 nm 

J-1700: 163 to 2500 nm 

[Data pitch] Selects the wavelength interval for data acquisition. 

Note: For J-1700, when the measurement start wavelength is 950 

nm or more, set the data pitchl to 0.1 nm or more. 

[Start mode] Selects the measurement start condition. 

Options: [Immediately], [Wait for ext trigger] 

Use [Wait for ext. trigger] when an optional accessory such as a 

stopped flow system is used. 

[Scanning mode] Selects the scanning mode. 

Options:  

[Continuous]: Continuous scan. Scans the wavelength at 

the speed specified in [Scanning speed]. 

[Step]: Step scan. Increments the wavelength in 

steps corresponding to the data 

wavelength interval, and performs 

measurements at each wavelength for a 

time specified by [D.I.T.] while the drive is 

stopped. The scanning speed depends on 

[D.I.T.]. In this case, the D.I.T. value is 

chosen automatically and cannot be 

selected. 

[Step (Auto)]: Performs a step scan while automatically 

adjusting D.I.T. to obtain a constant signal-

to-noise ratio. Selecting [Step (Auto)] 

displays [D.I.T. Upper] and [D.I.T. Lower] 

instead of [D.I.T.]. Click the arrows to 

display the drop-down lists and select the 

desired values. In the low signal-to-noise 

ratio region, the D.I.T. is automatically set 

between [D.I.T. Upper] and [D.I.T. Lower]. 

Note:  [Step (Auto)] is not displayed on the Basic Mode. 
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[Scanning speed] Specifies the scanning speed. Available if [Continuous] is selected for 

[Scanning mode]. 

J-1100: 1 nm/min to 5000 nm/min 

J-1500/1700: 1 nm/min to 10000 nm/min 

[NIR D. I. T.] Selects the data acquisition time (integration time) per point for NIR 

region. 

J-1700: 16 msec to 30 sec 

[NIR bandwidth] Selects the spectral bandwidth for NIR region. 

J-1700: 5nm to 50 nm 

[NIR slit width] Specifies the slit width within the range from 1 to 4000 m. Selecting 

[NIR slit width] activates the text box for entering the slit width. (only  

for J-1700) 

Accumulation/cycle  

[No. of cycles] Specifies the number of measurements for each sample. When 2 or 

more measurements are specified, the [Cycle interval] text box is 

displayed. 

Input range: 1 to 999 

Note: When the [Accumulation] check box is selected, [No. of 

cycles] is not displayed. 

[Accumulation] Specifies that cumulative averaging should be used to measure the 

spectrum. Selecting [Accumulation] displays [No. of accumulations]. 

[No. of 

accumulations] 

Specifies the number of measurements used to average the spectrum. 

If measurement is stopped, all completed accumulations are 

averaged. 
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7.1.2 [Control] tab 

 
Figure 7.3 [Control] tab in [Parameters] dialog box 

Correction  

[None] Selects the use of no correction. 

[Baseline] Selects baseline correction using a measured baseline. 

[Shutter is opened and 

closed automatically] 

Automatically opens the shutter just before the measurement 

starts and closes it after the measurement finishes, regardless 

of the current shutter status. Even when this option is selected, 

if cycle measurement is selected, the shutter is not closed 

between measurements.  

[Shutter is closed 

between measurements] 

Automatically closes the shutter between measurements, if 

cycle measurement is selected. 
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7.1.3 [Information] tab 

 
Figure 7.4 [Information] tab in [Parameters] dialog box 

[Sample name] Enters a sample name (maximum 63 characters). 

[Username] Enters a username (maximum 63 characters). 

[Division] Enters a division name for the operator (maximum 127 

characters). 

[Comment] Enters a comment (maximum 127 characters). 

[Concentration] Enters a sample concentration. There is no character 

limit. 

[Solvent] Enters a solvent name (maximum 127 single-byte 

characters). 

[Display the [Comments] 

dialog box before 

measurement] 

Displays the [Comments] dialog box for each 

measurement. 

Note: In the CFR version, the [Username] and [Division] text boxes cannot be changed by 

the user. 
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7.1.4 [Data] tab 

 
Figure 7.5 [Data] tab in [Parameters] dialog box 

Save data Selects to automatically save data. A file name is automatically 

allocated to the measured data and the data is saved to the 

specified directory. 

Note: In the CFR version, when [Auto save] is selected, the 

following dialog box is displayed when the sample 

measurement starts. Start the measurement after 

typing a signature. 

 

Figure 7.6 [Creation Signature (Auto Save)] dialog box 
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[Auto save] Automatically saves measured data. 

[CD data save in] Displays the drive and folder name for saving data. 

<Browse...> Browses to the [CD data save in] drive and folder. 

[Format] Selects the file name to be assigned during auto saving. The file 

format is Standard Files (*.jws). 

[Date-No.] Sets [Date] + [3-digit serial number] as the file name. The date 

and serial number are connected with a hyphen “-”. 

[Sample-No.] Sets [Sample name] + [3-digit serial number] as the file name. 

[Sample name] is the name entered in the [Information] tab. 

[Comment-No.] Sets [Comment] + [3 digit serial number] as the file name. 

[Comment] is the comment entered in the [Information] tab. 

[Sample-Comment-

No.] 

Sets [Sample name] + [Comment] + [3-digit serial number] as the 

file name. [Sample name] and [Comment] are the name and 

comment entered in the [Information] tab, respectively. 

[String-No.] Sets [String-No.] + [3-digit serial number] as the file name. Type 

the character string in the text box below the drop-down list 

(maximum 63 single-byte characters). 

[String] Enters a character string when [String-No.] is selected for 

[Format] (maximum 63 single-byte characters). 

[Auto export] Exports the measured data. 

[Save as type] Selects the file type for the exported data. 

Options: CSV Files, ASCII Files 

[Save export data to 

another folder] 

Selects to save the exported data to a separate folder. 

[Save in] Displays the drive and folder name for saving exported data. 

Note: In the CFR version, export data can be saved in a folder 

other than the workgroup folder. 

<Browse...> Browses to the [Save in] drive and folder. 

Send data Selects to automatically send measured data to the [Spectra 

Analysis] program after measurement. 

[To Spectra Analysis] Automatically sends measured data to the [Spectra Analysis] 

program after measurement. 

Print Selects to automatically print data after measurement. 

[Print data after 

measurement] 

Automatically prints data after measurement. 

[Template] Displays the drive and file name of a saved template file. 

<Browse...> Selects the drive and file name of a saved template file. 
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8. [Time Course Measurement] Program Reference 
The [Time Course Measurement] program measures the temporal change in the sample signal 

intensity at a fixed wavelength. This chapter describes specific measurement parameters for 

the [Time Course Measurement] program. 

 

8.1 [Parameters...] 
Specifies the measurement parameters. 

The window has four tabs for parameter settings, as shown in Figure 8.2 [General], Figure 8.3 

[Control], Figure 8.4 [Information], and Figure 8.5 [Data]. The [General] tab is open by default 

in the [Parameters] dialog box. The page can be changed by clicking each tab at the top of the 

dialog box. 

The parameters can be switched between two modes: Basic mode and Advanced mode. In 

Basic mode, the choice of parameters is partially limited. In Advanced mode, each parameter 

is specified individually. 
 

<Basic Mode/Advanced 

Mode> 

Switches between Basic and Advanced modes. Advanced mode 

can only be used for J-1500. 

<Open...> Opens a measurement parameter file. 

<Save...> Saves the measurement parameters. In the CFR version, an 

electronic signature is required for saving parameters. 

<Default> Restores the parameters of the [General] and [Control] tabs to their 

default values. 

<OK> Applies the changes to the [Parameters] settings and closes the 

dialog box. 

<Cancel> Closes the dialog box without applying any changes to the 

[Parameters] settings. 

Note 1: This operation can also be performed by clicking the tool button  [Parameters]. 

Note 2: In the CFR version, Managers or Analysts authority is required to specify the 

parameters. 

Note 3: In the CFR version, when the parameters are specified or changed, a signature is 

required. Clicking the <OK> button when the parameters have not been saved 

displays the following message. 

 

Figure 8.1 Message when the signature for the parameters is missing 
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8.1.1 [General] tab 

 
Figure 8.2 (a) J-1100/1500 [General] tab in [Parameters] dialog box 

 
Figure 8.2 (b) J-1700 [General] tab in [Parameters] dialog box 
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Photometric mode Selects the desired measurement parameters for the photometric 

mode. 

[Channels Num] Click the arrow (▼ or ▲) and select [Channels Num:] to display in the 

time-course data display field. 

Options: 1 to 4 

[Channel n] Selects the photometric mode for each channel. Click the drop-down 

list to select the photometric mode. 

[CD scale] Selects the CD/LD scale range for the detector in the transmission 

configuration. 

[20 mdeg/0.05 dOD]: High sensitivity mode. Available when the 

CD range is within ±20 mdeg and the LD 

range is within ±0.05 dOD. 

[200 mdeg/1.0 dOD]: Standard sensitivity mode. Available when 

the CD range is within ±200 mdeg and the 

LD range is within ±1.0 dOD. 

[2000 mdeg/1.0 dOD]: Wide range mode. Available when the CD 

range is within ±2000 mdeg and the LD 

range is within ±1.0 dOD. 

[10000 mdeg/1.0 dOD]: Maximum range mode. Available when the 

CD range is within ±10000 mdeg and the 

LD range is within ±1.0 dOD. 

[FL scale] Selects the FDCD/FDLD scale range for the C detector in the 

fluorescence configuration. 

[20 mdeg/0.05 dOD]: High sensitivity mode. Available when the 

FDCD range is within ±10 mdeg and the 

FDLD range is within ±0.05 dOD. 

[200 mdeg/1.0 dOD]: Standard sensitivity mode. Available when 

the FDCD range is within ±200 mdeg and 

the FDLD range is within ±1.0 dOD. 

[2000 mdeg/1.0 dOD]: Wide range mode. Available when the 

FDCD range is within ±2000 mdeg and the 

FDLD range is within ±1.0 dOD. 

[10000 mdeg/1.0 dOD]: Maximum range mode. Available when the 

FDCD range is within ±10000 mdeg and 

the FDLD range is within ±1.0 dOD. 

Note:  [FL scale] is not displayed on the J-1100. 

[D.I.T.] Selects the data acquisition time (integration time) per point. 

J-1100: 5 msec to 8 sec 

J-1500/1700: 0.1 msec to 30 sec 

[Bandwidth] Selects the spectral bandwidth. 

J-1100: 1 nm (fixed) 

J-1500/1700: 0.01 nm to 16.00 nm 
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[Slit width] Specifies the slit width within the range from 1 to 4000 m. Selecting 

[Slit width] activates the text box for entering the slit width. 

Note: [Slit width] is not displayed on the Basic Mode. 

[Wavelength] Specifies the measurement start wavelength. 

J-1100: 180 to 600 nm 

J-1500: 163 to 1600 nm 

J-1700: 163 to 2500 nm 

[Measuring time] Specifies the measurement time. 

Input range: 2 to 20002 sec 

[Data pitch] Selects the measurement interval for data acquisition. 

J-1100: 5 msec to 60 min 

J-1500/1700: 0.1 msec to 60 min 

[Start mode] Selects the measurement start condition. 

Options: [Immediately], [Wait for ext trigger] 

Use [Wait for ext. trigger] when an optional accessory such as a 

stopped flow system is used. 

[NIR D. I. T.] Selects the data acquisition time (integration time) per point for NIR 

region. 

J-1700: 16 msec to 30 sec 

[NIR bandwidth] Selects the spectral bandwidth for NIR region. 

J-1700: 5nm to 50 nm 

[NIR slit width] Specifies the slit width within the range from 1 to 4000 m. Selecting 

[Slit width] activates the text box for entering the slit width. (only for J-

1700) 

Note: [NIR slit width] is not displayed on the Basic Mode. 

Accumulation/cycle  

[No. of cycles] Specifies the number of measurements for each sample. When 2 or 

more measurements are specified, the [Cycle interval] text box is 

displayed. 

Input range: 1 to 999 

Note: When the [Accumulation] check box is selected, [No. of 

cycles] is not displayed. 

[Accumulation] Specifies that cumulative averaging should be used to measure the 

spectrum. Selecting [Accumulation] displays [No. of accumulations]. 

[No. of 

accumulations] 

Specifies the number of measurements used to average the spectrum. 

If measurement is stopped, all completed accumulations are 

averaged. 

Input range: 1 to 999. 

Note: “Accumulation/cycle” is not displayed on the Basic Mode. 
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8.1.2 [Control] tab 

 
Figure 8.3 [Control] tab in [Parameters] dialog box 

Correction  

[None] Selects the use of no correction. 

[Blank] Selects blank correction using a measured blank. 

[Shutter is opened and 

closed automatically] 

Automatically opens the shutter just before the measurement 

starts and closes it after the measurement finishes, regardless 

of the current shutter status. Even when this option is selected, 

if cycle measurement is selected, the shutter is not closed 

between measurements.  
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8.1.3 [Information] tab 

 
Figure 8.4 [Information] tab in [Parameters] dialog box 

[Sample name] Enters a sample name (maximum 63 characters). 

[Username] Enters a username (maximum 63 characters). 

[Division] Enters a division name for the operator (maximum 127 

characters). 

[Comment] Enters a comment (maximum 127 characters). 

[Concentration] Enters a sample concentration. There is no character 

limit. 

[Solvent] Enters a solvent name (maximum 127 single-byte 

characters). 

[Display the [Comments] 

dialog box before 

measurement] 

Displays the [Comments] dialog box for each 

measurement. 

Note: In the CFR version, the [Username] and [Division] text boxes cannot be changed by 

the user. 
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8.1.4 [Data] tab 

 
Figure 8.5 [Data] tab in [Parameters] dialog box 

Save data Selects to automatically save data. A file name is automatically 

allocated to the measured data and the data is saved to the 

specified directory. 

Note: In the CFR version, when [Auto save] is selected, the 

following dialog box is displayed when the sample 

measurement starts. Start the measurement after 

typing a signature. 

 

Figure 8.6 [Creation Signature (Auto Save)] dialog box 
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[Auto save] Automatically saves measured data 

[Save in] Displays the drive and folder name for saving data. 

<Browse...> Browses to the [Save in] drive and folder. 

[Format] Selects the file name to be assigned during auto saving. The file 

format is Standard Files (*.jws). 

[Date-No.] Sets [Date] + [3-digit serial number] as the file name. The date 

and serial number are connected with a hyphen “-”. 

[Sample-No.] Sets [Sample name] + [3-digit serial number] as the file name. 

[Sample name] is the name entered in the [Information] tab. 

[Comment-No.] Sets [Comment] + [3 digit serial number] as the file name. 

[Comment] is the comment entered in the [Information] tab. 

[Sample-Comment-

No.] 

Sets [Sample name] + [Comment] + [3-digit serial number] as the 

file name. [Sample name] and [Comment] are the name and 

comment entered in the [Information] tab, respectively. 

[String-No.] Sets [String-No.] + [3-digit serial number] as the file name. Type 

the character string in the text box below the drop-down list 

(maximum 63 single-byte characters). 

[String] Enters a character string when [String-No.] is selected for 

[Format] (maximum 63 single-byte characters). 

[Auto export] Exports the measured data. 

[Save as type] Selects the file type for the exported data. 

Options: CSV Files, ASCII Files 

[Save export data to 

another folder] 

Selects to save the exported data to a separate folder. 

[Save in] Displays the drive and folder name for saving exported data. 

Note: In the CFR version, export data can be saved in a folder 

other than the workgroup folder. 

<Browse...> Browses to the [Save in] drive and folder. 

Send data Selects to automatically send measured data to [Spectra 

Analysis] program after measurement. 

[To Spectra Analysis] Automatically sends measured data to the [Spectra Analysis] 

program after measurement. 

Print Selects to automatically print data after measurement. 

[Print data after 

measurement] 

Automatically prints data after measurement. 

[Template] Displays the drive and file name of a saved template file. 

<Browse...> Selects the drive and file name of a saved template file. 
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9. [Data Monitor] Program Reference 
The [Data Monitor] program is used to provide an enlarged display of the photometric values 

when the CD spectrometer is being tested or calibrated. This chapter describes specific 

measurement parameters for the [Data Monitor] program. 

Note: In the CFR version, [Data Monitor] program is not available. 

 
Figure 9.1 [Data Monitor] digital-mode display  

 
Figure 9.2 [Data Monitor] graph-mode display 
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9.1 [Parameters…] 
Specifies the measurement parameters. 

<OK> Applies the changes to the [Parameters] settings and closes the dialog box. 

<Cancel> Closes the dialog box without applying any changes to the [Parameters] 

settings. 

Note: This operation can also be performed by clicking the tool button  [Parameters]. 

9.1.1 [Parameters] 

 
Figure 9.3 (a) J-1100/1500 [General] tab in [Parameters] dialog box 

 
Figure 9.3 (b) J-1700 [General] tab in [Parameters] dialog box 
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Photometric mode Selects the desired measurement parameters for the photometric 

mode. 

[Channels Num] Click the arrow (▼ or ▲) and select [Channels Num:] to display in 

the time-course data display field. 

Options: 1 to 4 

[Channel n] Selects the photometric mode for each channel. Click the drop-down 

list to select the photometric mode. 

[CD scale] Selects the CD/LD scale range for the detector in the transmission 

configuration. 

[20 mdeg/0.05 dOD]: High sensitivity mode. Available when the 

CD range is within ±20 mdeg and the LD 

range is within ±0.05 dOD. 

[200 mdeg/1.0 dOD]: Standard sensitivity mode. Available 

when the CD range is within ±200 mdeg 

and the LD range is within ±1.0 dOD. 

[2000 mdeg/1.0 dOD]: Wide range mode. Available when the 

CD range is within ±2000 mdeg and the 

LD range is within ±1.0 dOD. 

[10000 mdeg/1.0 dOD]: Maximum range mode. Available when 

the CD range is within ±10000 mdeg and 

the LD range is within ±1.0 dOD. 

[FL scale] Selects the FDCD/FDLD scale range for the C detector in the 

fluorescence configuration. 

[20 mdeg/0.05 dOD]: High sensitivity mode. Available when the 

FDCD range is within ±20 mdeg and the 

FDLD range is within ±0.05 dOD. 

[200 mdeg/1.0 dOD]: Standard sensitivity mode. Available 

when the FDCD range is within ±200 

mdeg and the FDLD range is within ±1.0 

dOD. 

[2000 mdeg/1.0 dOD]: Wide range mode. Available when the 

FDCD range is within ±2000 mdeg and 

the FDLD range is within ±1.0 dOD. 

[10000 mdeg/1.0 dOD]:Maximum range mode. Available when 

the FDCD range is within ±10000 mdeg 

and the FDLD range is within ±1.0 dOD. 

Note:  [FL scale] is not displayed on the J-1100. 

[D.I.T.] Selects the data acquisition time (integration time) per point. 

J-1100: 5 msec to 8 sec 

J-1500/1700: 0.1 msec to 30 sec 
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[Bandwidth] Selects the spectral bandwidth. 

J-1100: 1 nm (fixed) 

J-1500/1700: 0.01 nm to 16.00 nm 

[Slit width] Specifies the slit width within the range from 1 to 4000 m. Selecting 

[Slit width] activates the text box for entering the slit width. 

[Wavelength] Specifies the measurement start wavelength. 

J-1100: 180 to 600 nm 

J-1500: 163 to 1600 nm 

J-1700: 163 to 2500 nm 

[Monitoring time] Specifies the monitoring time when graph mode is selected. 

Input range: 10 to 30000 sec 

[NIR D. I. T.] Selects the data acquisition time (integration time) per point for NIR 

region. 

J-1700: 16 msec to 30 sec 

[NIR bandwidth] Selects the spectral bandwidth for NIR region. 

J-1700: 5 nm to 50 nm 

[NIR slit width] Specifies the slit width within the range from 1 to 4000 m. Selecting [Slit 

width] activates the text box for entering the slit width. (Only J-1700) 
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10. Appendix 

10.1 Setting the Measurement Parameters 
The parameters selected can seriously affect measurement results. The following summarizes 

how to select parameters. 

 

10.1.1 Measurement Wavelength Range 

Most CD spectrum peaks appear in a specific wavelength region (short wavelength region as 

in the case of ultraviolet-visible absorption spectra for most organic compounds). If the optically 

active absorption band position for the sample is known, take measurements beginning at a 

wavelength of 50 to 100 nm before the leading edge of the spectrum and ending at the trailing 

edge of the spectrum where it converges at zero, although this method varies slightly 

depending on the width and shape of the spectrum. 

 

10.1.2 Data Acquisition Interval (Resolution) 

10.1.2.1 Spectra measurement 

Usually, a value of about 0.2 nm is sufficient. However, if the scanning mode is set to [Step], 

approximately 1 nm is more appropriate. Make the resolution coarse if the spectrum peaks are 

broad and fine if they are sharp. 

 

10.1.2.2 Time-course measurement 

Make the resolution fine if rapid changes with time are expected. 

 

10.1.3 Scanning Speed 

The scanning speed depends on the D. I. T. Under normal conditions, set the scanning speed 

at 20 to 100 nm/min and D. I. T. at 0.25 to 2 sec. Table 10.1 shows suggested D.I.T. values 

for different scanning speeds. 

Table 10.1 D.I.T. values for different scanning speeds 

Scanning speed (nm/min) D.I.T. (recommended) Upper limit 

10000 1.0 to 2.0 msec 32.0 msec 

5000 2.0 to 4.0 msec 64.0 msec 

2000 4.0 to 8.0 msec 0.25 sec 

1000 32.0 msec to 0.125 sec 0.5 sec 

500 64.0 msec to 0.25 sec 1.0 sec 

200 0.125 to 0.5 sec 2.0 sec 

100 0.25 to 1.0 sec 4.0 sec 

50 0.5 to 2.0 sec 8.0 sec 

20 1.0 to 2.0 sec 16.0 sec 

10 2.0 to 4.0 sec 16.0 sec 

5 2.0 to 8.0 sec 16.0 sec 

2 4.0 to 16.0 sec 16.0 sec 

1 8.0 to 16.0 sec 16.0 sec 
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10.1.4 Number of Accumulations 

The following relationship exists between the signal-to-noise ratio and the number of 

accumulations: S/N ∝ √(Number of accumulations). 

Increasing the number of accumulations improves the signal-to-noise ratio for a spectrum. 

Determine the appropriate number of accumulations based on the spectrum (sample) condition 

and the overall measurement time (increasing the number of accumulations prolongs the 

measurement time). 

If the sensitivity is lower than Standard, a single accumulation will suffice. Table 10.2 shows 

the suggested number of accumulations when a sample with an absorbance of 1 or less is 

measured with a D.I.T. of 2 sec. 

Table 10.2  No. of accumulations and sensitivity (D.I.T. 2 sec) 

Sensitivity Number of accumulations 

High 4 to 50 

Standard, Low 1 

Note: For time-course measurements, set the number of accumulations to 1. Cumulative 

measurement can be used in stopped flow measurement (see the instruction manual 

for the stopped flow unit). 

10.1.5 Response (D.I.T.) 

10.1.5.1 Spectra measurement 

The following relationship exists between D.I.T. and the signal-to-noise ratio: 

S/N ∝ √𝑅𝑒𝑠𝑝𝑜𝑛𝑠𝑒. 

The signal-to-noise ratio for a spectrum measured for 4 seconds is twice that for a spectrum 

measured for 1 second. 

The spectral value at any given point in time is the average of values sampled before and after 

that time (D.I.T./2). Therefore, increasing D.I.T. leads to a greater effect of previous data on 

the current data. Do not increase D.I.T. excessively if scanning is carried out at high speed or 

if the resolution is low. 

Table 10.3 shows suggested D.I.T. values for obtaining a spectrum with a high signal-to-noise 

ratio at a desired sensitivity. If the sensitivity is set at 10 mdeg and D. I. T. is set at 1 to 2 sec 

to improve the signal-to-noise ratio, increasing the number of accumulations is very effective 

because the spectrum is simultaneously averaged. 

Table 10.3 D.I.T. values for obtaining high signal-to-noise ratio 

CD scale (mdeg) D.I.T. (sec) 

10 0.5 to 16.0 

200 0.125 to 0.5 

2000 0.025 to 0.064 

Note: A D.I.T. of 0.5 to 125 msec should be selected for high speed measurement using a 

stopped flow unit. 
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The above table also applies to a step scan. In this case, the measurement time is the sum of 

the wavelength stepping time and the data acquisition time at each step. If the D.I.T. is on the 

order of seconds, the number of accumulations will dominate the measurement time and the 

measurement time will be almost proportional to D.I.T. For a total wavelength measurement 

range of W (nm) and a data interval of Step (nm), the following relation holds between the total 

integration time and D.I.T. 

 Total Integration Time = (W/Step + 1)  D.I.T. 

 (W/Step + 1): Number of data points 

10.1.5.2 Time-course measurement 

For time-course measurement, select a D.I.T. that is appropriate given the decay half-life of 

the CD signal due to a reaction. For normal reactions, set it to 1/10 of the decay half-life of the 

CD signal or smaller. For example, if the decay half-life is 20 msec, a D.I.T. of 0.5 to 2 msec is 

appropriate. If the decay is very slow, select a D.I.T. of 1 to 16 sec, taking into account the rate 

of change of the signal and the signal-to-noise ratio. When used as a monitor for HPLC, a D.I.T. 

of about 1 sec is suitable. 

 

10.1.6 Bandwidth and slit width 

In most cases, set the measurement bandwidth to 1.0 nm. Decrease it when measuring a 

sharp spectrum such as a MCD (magnetic circular dichroism) spectrum, or increase when 

performing measurements using a micro cell, when the signal-to-noise ratio is low. When a 

longer wavelength detector (400 to 1100 nm) is used, increase the bandwidth and set the slit 

width to about 60 μm to prevent the photomultiplier voltage (HT) from rising abnormally. 

However, ensure that the HT voltage does not become lower than 170 V. 

Note 1: If the slit width is increased until the HT voltage drops below 170 V, the photomultiplier 

may be damaged. 

Note 2: Most organic substances emit fluorescence. Therefore, measuring a sample having 

an absorbance of 2 or more at a bandwidth of 2 nm or more may distort the spectrum. 

Also, photolysis of a sample can occur in the ultraviolet region. If the sample is 

susceptible to photolysis, reduce the bandwidth to 0.5 nm or less. 
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